
Welcome to Graphic Workshop Professional’s Help. The information in the help 
selection is a subset of what’s available in the Manual installed with your software. If 
you don’t find what you need here, or if you require additional clarification, please 
consult the Manual and its dependent documents.

          Help with Graphic File Formats  

          Help with Configuring Graphic Workshop Professional  

          Help with Using Graphic Workshop Professional  

          Help with Registering Graphic Workshop Professional  

          Help with Contacting Alchemy Mindworks  



Help with Graphic File Formats

          ART   Johnson-Grace / AOL
          AVI   Video for Windows movies
          BGA   OS/2 graphic arrays
          BMP   Windows and OS/2 bitmaps
          CAM   Casio digital camera images
          CDR   Corel Draw bitmaps and previews
          DCX   FAX documents
          EXE   self-displaying pictures
          FIF   Fractal-compressed images
          FITS   Astronomical images
          FLI/FLC   Autodesk animations
          FPX   FlashPix
          GIF   Graphics and animations
          IMG   GEM/Ventura images
          CUT   Halo images
          HRZ   slow-scan television
          ICO   Windows icons
          IFF/LBM   Amiga images
          JPEG   Photorealistic images
          KDC   Kodak digital camera images
          KQP   Konica Quality Photos
          MAC   MacPaint files
          MIDI   Sequenced music
          MOV   Apple QuickTime movies
          MPEG   MPEG movies
          MSP   Windows 2.0 Microsoft Paint images
          PCD   Kodak Photo-CD images
          PCX   PC Paintbrush images
          PIC   GLPaint images
          PNG   Portable Network Graphics
          PSD   Photoshop images
          RLE   Windows compressed bitmaps
          SCR   Windows screen savers
          SFW   Seattle Film Works images
          SGI   Silicon Graphics images
          RAS   Sun raster image
          TGA   Targa images
          TIFF   Tagged Image File Format images
          TTF   TrueType fonts
          TXT   Text files
          UUE   UUencoded graphics
          WAV   Windows sampled sound files
          Wallpaper   Windows wallpaper
          WMF   Windows metafiles
          WPG   WordPerfect Graphics
          XBM   XWindows bitmaps



ART – Maximum bits: 24

The ART format uses a proprietary compression structure created by Johnson-Grace. 
As of this writing, ART technology is owned by America On Line. Many files 
downloaded from AOL are stored in the ART format. As an aside, a not-insubstantial 
number of files having the extension JPG are really ART files inside. If you have 
trouble reading a downloaded JPEG file, try renaming it with the extension ART.

The ART format uses lossy compression to create smaller files – there's a more 
detailed discussion of lossy compression elsewhere in this document as it pertains to 
JPEG files. The JPEG/ART Quality item it Setup will define the degree of compression 
of ART files written by Graphic Workshop.

There's a second extant format which uses the extension ART – it was used to create 
graphics for the PFS:First Publisher application some years back. It only supports 
monochrome images. Graphic Workshop will read uncompressed PFS:First Publisher 
ART files if it encounters them – it always writes Johnson-Grace ART files.



AVI files – Maximum bits: 24

AVI files contain Video for Windows animation. The can have any dimensions, 
although they tend to be fairly small. Graphic Workshop will allow you to read 
individual frames from an AVI file, display the whole file as an animation sequence and 
convert other selected animated formats to AVI.

Note that Graphic Workshop will not convert between animated GIF files and AVI files. 
See our GIF Construction Set software at http://www.mindworkshop.com for this 
functionality.

You must have the Video for Windows drivers installed for the AVI functions to work 
properly. These are typically installed as part of Windows 95, 98 and NT 4.0. If the AVI 
functions don't work, you have driver problems.



BGA Files – Maximum bits: 24

The BGA format is used by some OS/2 Warp applications. It can contain multiple 
images and is actually a variation on the OS/2 BMP format. If you attempt to read a 
BGA file which contains multiple images, a dialog will appear to allow you to select the 
image you're interested in. 

Converting an image to the BGA format will result in a single-image BGA file.



BMP/DIB files – Maximum bits: 24

BMP files are used as wallpaper under Windows. They can be created using the 
Paintbrush application supplied with Windows, among other things. The BMP and DIB 
formats are identical – DIB files are used in some programming and multimedia 
applications.

Note that the OS/2 also supports graphic files with the extension BMP. These are 
distinct from Windows BMP files. Graphic Workshop will read both types. You can 
configure it to write either type by setting the Write OS/2 Bitmaps switch in Setup



CAM files (Casio Digital Camera) – Maximum bits: 24

These files are created by Casio's digital cameras. Graphic Workshop will read them 
and convert them to other formats, but it will not write to the CAM format.



CDR files – Maximum bits: 24

Graphic Workshop's use of CDR files is a bit peculiar. You'll save yourself a degree of 
frustration if you read this section before working with CDR files. Note that there are 
two distinct modes under which Graphic Workshop can read CDR files.

Corel Draw's CDR files are vector graphics, but they contain small preview or 
thumbnail images which appear in the Corel Draw File Open dialog and in the Mosaic 
browser application. Graphic Workshop will read these preview images – it will not 
read the actual line art graphics in CDR files. The preview images are very coarse, but 
they're useful for quickly ascertaining what's in a CDR file.

Alternately, Graphic Workshop can be instructed to search CDR files created with 
Corel Draw 4 and 5 for bitmap objects. If one or more bitmaps are found, Graphic 
Workshop will read these as if they were conventional bitmap images. This is handy, 
for example, should you wish to extract a bitmap from a CDR file with no loss of 
resolution. If no bitmaps are present, Graphic Workshop will show you the CDR 
thumbnail preview for the file. If more than one bitmap is present, a dialog will appear 
to prompt you to choose one of the available images

Enable the Read CDR Bitmaps switch in Setup to have Graphic Workshop troll CDR 
files for bitmaps, or disable it to have it display thumbnails for all CDR files.

If Graphic Workshop only reads a thumbnail image from your CDR files, it will allow 
you to convert from CDR, but you'll be converting the preview images. This will not be 
attractive. Should you contact us and ask us why converting from CDR thumbnail
images results in a small, coarse graphic that's nowhere near as good as it 
looks in Corel Draw, our leather winged demon of the night will make a special 
trip over to visit you and rip out your lungs.



DCX files – Maximum bits: 1

The DCX format is used to store FAX documents. DCX files can include multiple 
pages. If you attempt to view or process a multiple-page DCX file, a dialog will appear 
to prompt you for the page to read. Graphics converted to DCX will be written to 
single-page files. Note that only monochrome graphics can be converted to the DCX 
format.



EXE files (self-displaying pictures) – Maximum bits: 8

You can convert images having between two and 256 colours to files with the 
extension EXE. Such files are self displaying pictures. For example, if you have a file 
called PICTURE.GIF and you use Graphic Workshop to translate it to PICTURE.EXE, 
typing PICTURE from the command line will cause the picture to display on your 
screen.

Note that Graphic Workshop installs with the EXE format initially disabled. You must 
enable it in the Formats dialog from the File menu before Graphic Workshop will read 
or create EXE pictures.

The EXE pictures created by Graphic Workshop for Windows can be either DOS or 
Windows applications. You can define which type of picture to create with the 
Windows EXE Pictures switch in Setup.

Pictures written into the EXE format can subsequently be read back into any other 
format. However, note that Graphic Workshop can only read EXE files which it has 
created. Use the Get Info function to check out EXE files if you aren't sure whether 
they're pictures or programs.

Graphic Workshop will not read self displaying pictures written by other applications.

There's a lot more about EXE pictures in the Manual document.



FIF files – Maximum bits: 24

FIF files are created by software from Iterated Systems' fractal compression 
technology. They can be thought of as being similar in nature to JPEG files, in that 
fractal compression deletes some of the detail from a compressed image in order to 
achieve better compression. The visible nature of the image degradation of FIF files 
will vary somewhat from that of JPEG files.

Graphic Workshop is only able to read FIF files – due to licensing restrictions by 
Iterated Systems, it will not convert files from other formats to FIF.

As with JPEG files, you can tell Graphic Workshop to treat FIF files as being either 
eight- or 24-bit entities. The Read JPEG/FIF as RGB switch in Setup defines this – 
turn it on for 24-bit reading. Reading a FIF file with this switch off will cause it to be 
dithered to 256 colours.



FITS files – Maximum bits: 24

The FITS format is used to store images from telescopes and other astronomical 
sources. Graphic Workshop supports a subset of FITS. Specifically, it will only handle 
images with two axis correctly. FITS files can contain more than eight bits of grey scale
information, but as no PC display hardware exists that can display it, images with 
higher resolution will be reduced to eight bits of grey for display and conversion. 

It won't take you much work to find FITS files that Graphic Workshop will not display. 
FITS files are often used to contain images which aren't simple two-dimensional flat 
graphics.

If you write an image to a FITS file, it will be stored as an eight-bit grey scale picture.



FLI and FLC files – Maximum bits: 8 

The FLI and FLC formats are a DOS-based animation protocol developed by 
AutoDesk. All FLI files are constrained to have the dimensions 320 by 200 with eight 
bits of colour, and most FLC files do as well. At present the FLI and FLC formats do 
not support sound. 
 
The FLI and FLC formats use simple run length compression. Note that complex 
frames which don't compress well can result in really huge FLI or FLC files. The raw 
data for a 100-frame FLI file would require over six megabytes of storage. 



FPX files (FlashPix) – Maximum bits: 24

The ultimate in flexible image file formats or the graphic standard from hell – we favour
the latter – FlashPix is designed for photorealistic imaging and specifically for the 
manipulation of pictures from digital cameras. Graphic Workshop will view FlashPix 
images and convert them to other formats. It will not convert images to the FlashPix 
format as of this writing, pending the resolution of some problems with the FlashPix 
libraries.



GIF files – Maximum bits: 8

These can range from monochrome to 256-colour images in any size you can find 
them. Graphic Workshop supports both the 87a and 89a versions of the GIF standard

In order to view GIF files having more than one image, or to view animated GIF files in 
real time, the Multiple Image GIF Files item in Setup must be enabled. Note that this 
may significantly increase the access time for some GIF files.

GIF files can be created using either interlaced or non-interlaced storage. An interlaced
GIF file has its lines stored in a non-linear order. This will in no way affect how your 
GIF files will look in Graphic Workshop – they'll appear in interlaced order if they're 
displayed in a web browser. To have Graphic Workshop write interlaced GIF files, 
select the Write GIF Interlaced option in Setup.

By default, if you attempt to view an animated GIF file, Graphic Workshop will display it
as such. It can alternately be configured to prompt you to select which of its discrete 
images you'd like to look at. If you don't want to have it automatically view animated 
GIF files, turn on Prompt to View Animation in Setup.



GEM/IMG files – Maximum bits: 24

GEM/IMG is a fairly ancient format, and you probably won't want to bother with it 
unless you like old versions of Ventura Publisher. There are actually quite a few 
variations on IMG files... they handle monochrome and grey level images. Graphic 
Workshop supports files with up to 256 levels of grey and 24-bit IMG files with up to 
sixteen-million colours. Note that 24-bit IMG files are only supported by Ventura 4.0 
and better.



CUT files (Halo) – Maximum bits: 8

The CUT format is exceedingly awkward, and Graphic Workshop makes a few 
assumptions about how CUT files will be used in order to make it workable. To begin 
with, CUT files don't know how many colours they have in them. They rely on a second
file, called a PAL file, to define their colours.

Graphic Workshop looks for a PAL file to decide whether a CUT file has two bits or 
eight bits of colour. If it doesn't find a PAL file with the same name as your CUT file, it 
will assume that the CUT file in question only has two bits of colour. Otherwise, it will 
assume that there are 256 colours in the file.

Files written to the CUT format from Graphic Workshop will appear as two-colour files 
if they started out that way or as 256-colour files if they had more than two colours 
initially. 



HRZ files (Slow Scan Television) – Maximum bits: 24

Images in the HRZ format always have 24 bits of colour and the fixed dimensions 256 
by 240 pixels. Images with differing dimensions will be padded or cropped to fit in this 
space when they're translated to HRZ. Images with fewer colours will be promoted to 
24 bits. This is a fairly specialized format – if you aren't using slow scan television, you 
probably don't need it. You might well ask what slow scan television is – damned if we 
know. Conventional television seems slow enough.



ICO files (Windows icons) – Maximum bits: 4

ICO files are used to contain Windows icons. They're very small bitmaps. If you 
convert a larger bitmap to ICO, only the upper left corner of the source image will 
appear in your icon. Investigate the Graphic Workshop Scale and Crop modes if 
you're creating icons. You might also have recourse to the Effects Colour Reduction 
function if your source images have more than sixteen colours.

Graphic Workshop will read icons of any size and colour depth recognized by Microsoft
Windows. It will only write 32 by 32 pixel, sixteen- or 256-colour icons. 



IFF/LBM files – Maximum bits: 24

IFF files originated with the Amiga. The IFF file standard is extremely flexible and it 
supports all sorts of things besides storing images. IFF files are found in PC 
environments PC having been ported from Amiga systems. They are also created on 
the PC by several applications such as Electronic Arts' Deluxe Paint – in this case they
may have the extension LBM.

Note that Graphic Workshop only reads "pure" IFF files, and will not handle the 
countless variations on the format which have appeared on Amigas. Specifically, it 
does not read hold and modify, or HAM, files.



JPG files (Joint Picture Experts Group) – Maximum bits: 24

The JPEG format is actually a combination of several elements, and it's important that 
you understand what it does before you use it. The JPEG algorithm reduces the 
amount of space a compressed image will occupy on disk by selectively removing 
details from the image. Pictures with fewer details compress more effectively. The 
amount of detail removal is defined by the JPEG/ART Quality item in Setup. 

At the default value of 75, relatively little picture degradation will take place but a 
significant amount of compression will be obtained. At lower values you'll experience 
still better compression, but with a marked loss of image quality. 

Once an image has been converted to JPEG, its lost details are lost for good. Note 
also that repeatedly reading and writing the same image in the JPG format will 
successively degrade it – it's a very bad idea to convert from JPG to JPG, as your 
pictures will get a bit uglier each time you do so. 

Note: All colour JPEG files are 24-bit images, having sixteen-million colours. Because 
some systems can only display 256 colours directly, JPEG files can be read as 256-
colour images. This actually means that they'll be dithered when they're read. To have 
your JPEG files read as 24-bit images, enable the Read JPEG as RGB item in Setup. 
Disable this item to have them read as 256-colour images. The number of colours 
displayed in the Get Info box will reflect the setting of this switch. 
 
The best way to convert from JPEG to a 256-colour format, such as GIF, is to enable 
the Read JPEG as RGB switch and then use the Colour Reduction option of Effects.

Graphic Workshop includes support for progressive JPEG. A progressive JPEG file will
initially appear blurred if it's part of a web page or other on-line service, and will resolve
as more of the file is transmitted. Graphic Workshop will read and write progressive 
JPEG file but it will not display them progressively – that is, if you view progressive 
JPEG file, it will appear as a single sharp image. You can determine whether Graphic 
Workshop writes conventional or progressive JPEG files through the Write 
Progressive JPEG switch in Setup. Note that most applications with JPEG support 
will not read progressive JPEG files.



KDC files (Kodak Digital Science) – Maximum bits: 24

KDC files are created by Kodak's digital cameras. Graphic Workshop will read them 
files and convert them to other formats, but it will not write to the KDC format.

Graphic Workshop will read KDC files created by Kodak DC30, DC40, DC50 and 
DC120 cameras, but not DC20 cameras. If you need to read DC20 KDC files, see the 
sixteen-bit version of Graphic Workshop classic. More recent Kodak digital cameras 
save their images in the FlashPix format, discussed elsewhere in this document.



MAC files (MacPaint) – Maximum bits: 1

MacPaint files come in two flavours. The most common one is straight ported 
MacPaint files, that is, files having a "MacBinary" header. The other is "headerless" 
files, having no MacBinary header. Graphic Workshop reads both types, but if you 
convert a file from a different format to MacPaint format the file will be written in 
accordance with the setting of the MacBinary Header item in Setup.

Files converted to the MacPaint format from other formats will be cropped or padded 
out as necessary to fit in the MacPaint format's 576 by 720 format. Only monochrome 
files can be converted to MacPaint, as MacPaint in a monochrome-only format.



MID files (MIDI Music)

MIDI files aren't graphics – they're sequenced music. None the less, you can browse 
them with Graphic Workshop. If you "view" one, a small bitmap will appear and the 
music in the file will play. Note that the Play item in the Picture menu of View mode can
be used to repeat a MIDI file once it finishes. If you attempt to convert a MIDI file to a 
graphic format, the resulting graphic file will contain a copy of the MIDI bitmap that 
appears in View mode.

MIDI files display in Graphic Workshop's browser windows with a canned thumbnail.

You must have the MCI sequenced music drivers installed for the MIDI functions to 
work properly. These are typically installed as part of Windows 95, 98 and NT 4.0. If 
the MIDI functions don't work, you have driver problems.



MOV files (Apple QuickTime) – Maximum bits: 24

QuickTime movies are a tragic tale, and Graphic Workshop's involvement with them 
will prove very cursory. It will play MOV files but it will not convert to or from MOV, a 
situation that's not likely to change in the foreseeable future.

Without getting into all the hoary details of our brief flirtation with Apple, adding 
complete QuickTime support proved to be prohibitively expensive. As we weren't 
prepared to raise the price of Graphic Workshop to deal with what is in reality a pretty 
obscure animation format, we decided to forgo this feature.

We have included hooks in Graphic Workshop which will allow it to play QuickTime 
movies if you have the QuickTime MCI drivers installed in your system. If you do not 
have these drivers installed, attempting to play a QuickTime movie will generate an 
error message.

We regret the inconvenience this situation may cause users of Graphic Workshop – 
the whole ordeal has left us pretty confused. We felt that some QuickTime support 
would be better than none at all, especially for Graphic Workshop users who require 
the software primarily for viewing files.

You must have the QuickTime MCI drivers installed for the MOV functions to work 
properly. These are typically installed as part of Windows 95, 98 and NT 4.0. If the 
MOV functions don't work, you have driver problems.



MPG files – Maximum bits: 24

Graphic Workshop will display the video of MPEG animations. It will not convert MPEG
to other formats, or other formats to MPEG.

MPEG files display in Graphic Workshop's browser windows with a canned thumbnail.



MSP files – Maximum bits: 1

These are the image files used by the paint application which came with Microsoft 
Windows version 2. MSP files only support monochrome images.



PCD (Kodak Photo-CD) files – Maximum bits: 24

Kodak Photo-CDs allow you to have conventional photographs converted to Kodak's 
proprietary CD-ROM format. The resulting files can be viewed, converted and treated 
like other PC file formats. Having your photographs made into Photo-CDs will avail you
of very high grade scanning even if you don't own a scanner.

Photo-CD image files usually reside in a directory named \PHOTO_CD\IMAGES on a 
Photo-CD. They're named by the following convention:

IMGxxxx.PCD

where xxxx is a four digit number, beginning with one for the first image. 

Each PCD file contains a number of scans of the same image at different resolutions. 
The very low resolution images are used for thumbnail previews. Medium-level images
are useful to view and work with Photo-CD scans in a PC environment. 

You can tell Graphic Workshop to read Photo-CD images at a specific resolution 
through the Photo-CD Read Options item in Setup. If you choose one of the 256-
colour options you'll see dithered images – these are useful if display card only 
supports 256 colours. If you choose one of the RGB options you may see coarse 
dithered images when you view a Photo-CD image, but you'll be able to convert PCD 
files to high quality true colour images for use with colour separation and desktop 
publishing software, photographic retouching packages, such as Photoshop. Choose 
one of the grey scale options if you will be outputting your Photo-CD images to a 
monochrome device, such as a laser printer. Note that if you choose a resolution which
is not available on your Photo-CD, the next available resolution will be substituted.

If you use Graphic Workshop to convert from PCD files to another format, you must 
enable the Prompt for Destination option in Setup. If you don't do this, Graphic 
Workshop will attempt to write its converted files to your CD-ROM drive, which would 
be a bit tricky, CD-ROMs being read-only.

The thumbnails for PCD files are not handled like thumbnails for other file formats. 
Specifically, there are no THN files used – the images are actually the lowest-
resolution scans in the PCD files in question. This means that you cannot use the 
Details and Search functions with PCD thumbnails.



PCX files – Maximum bits: 24

PCX is a very old image file standard – it originated with Z-Soft's PC Paintbrush 
software back in the late Jurassic period. It's widely supported as a graphic file format. 
PCX files can range from monochrome to 24-bit images. All the various formats are 
supported by Graphic Workshop.



PIC files – Maximum bits: 24

These should not be confused with Lotus 1-2-3 PIC drawing files. PIC files are created
by GLPaint/GLPro and are used by Grasp, among other things.

At present, Graphic Workshop writes 24-bit images to the PIC format as type one high 
colour files, that is, with fifteen bits of colour information. 

In addition to reading PIC files from the GL Paint package, Graphic Workshop will also 
read PIC files generated by Pegasus software. The Pegasus PIC format is used by 
several commercial photofinishers who provide photographs on floppy disks.

The KQP files used by Konica's digitial photofinishing services are also Pegasus PIC 
files, and will be read by Graphic Workshop.



PNG files – Maximum bits: 24

The PNG, or "Portable Network Graphics," format was created as a successor to GIF. 
It features lossless compression for images with up to 24 bits of colour and most of the
other features of GIF. In most cases it will provide at least slightly letter compression 
than GIF. 

PNG files can be interlaced or non-interlaced. This won't affect how PNG images look 
in Graphic Workshop, but interlaced PNG files will cause Graphic Workshop to pause 
momentarily before its status bar begins to indicate that something's happening.

The PNG Compression control in Setup defines how hard Graphic Workshop will try 
to compress PNG files. It can range between one and nine. If it's set to one, PNG files 
written with Graphic Workshop will not be all that well compressed, but they'll write 
quickly. If it's set to nine, Graphic Workshop will usually manage to create smaller PNG
files, but it will take a lot longer to do so. Intermediate settings will represent a tradeoff 
between these two extremes. Note that this setting will not affect the quality of an 
image stored in a PNG file – it only deals with the compression effectiveness and the 
time it takes to write a PNG file.



PSD files (Adobe Photoshop) – Maximum bits: 24

The PSD format is native to Adobe Photoshop. It can store images having up to 24 bits
of colour – it also allows for transparency and several other options which are not 
supported by Graphic Workshop. PSD files can be stored either uncompressed or 
compressed using run-length compression. The latter is typically not very effective on 
photorealistic subjects. Enable Compress IFF/LBM/PSD Files in Setup to have 
Graphic Workshop write compressed PSD files.



RLE files – Maximum bits: 8

The RLE format is actually a variation on the BMP format discussed previously. It uses 
rudimentary image compression.

Graphic Workshop for Windows will read most RLE files from other sources. One 
known exception is the VGALOGO.RLE file provided with Windows 3.1.



Screen Savers

Windows screen savers are actually specialized applications which are run 
automatically by Windows when your system has been idle for a predetermined time. 
Screen savers have the file extension SCR.

Graphic Workshop will convert graphics in other formats to screen savers. In fact, 
when you perform this conversion, Graphic Workshop creates an application to display
your pictures as screen savers and embeds your graphic in the application. Graphic 
Workshop's screen savers can be run on systems which do not have Graphic 
Workshop installed on them – they are self-contained screen savers.

Graphic Workshop screen savers can be configured to display your graphics with a 
number of animated transitions. Users of these screen savers can define which 
transitions they'd like to see.

Having converted a graphic to the SCR format with Graphic Workshop, you must copy 
the SCR file you have created to your \WINDOWS directory. Alternately, simply have 
Graphic Workshop write it directly to \WINDOWS. Open the Windows Control Panel 
and select Display. Click on the Screen Saver tab and select GWSPRO Screen Saver 
as your default screen saver. Click on the screen saver Setup button to access the 
screen saver configuration dialog.

Graphic Workshop's screen savers can display graphics with your choice of one or 
more of the following animated transitions. If you disable all these options, your 
graphics will appear and disappear with no animation.

Chaos and Order: Your graphics will appear as a sequence of random tiles which 
are gradually sorted into their correct order.

Horizontal Split: Your graphics will appear to split horizontally and move together.

Plummet: Your graphics will appear as vertical bands which descend into your 
screen area.

Quadrants: Your graphics will appear in four sections which resolve into a 
complete image.

Sandstorm: Your graphics will appear one pixel at a time, in random order. 

Tile: Your graphics will appear one tile at a time, in random order.

Vertical Split: Your graphics will appear to split vertically and move together.

Wipe in from Left: Your graphics will wipe in from the left.

Wipe in from Right: Your graphics will wipe in from the right.

The Setup dialog will also allow you to set the image duration – the time your graphics 
will be displayed between animated transitions – and the Random Placement switch. 



The latter option can be enabled to cause your graphics to appear at a different 
location every time they're displayed, or disabled to centre them.

The Test button in the Setup dialog will display your screen saver as it will appear 
when your screen is actually blank. Click anywhere in the screen to end the test. This 
feature is duplicated by the Preview button in the Windows Display under Windows 95,
98 and NT applet – it's included here for users of Windows 3.1.

Screen savers created with an unregistered copy of Graphic Workshop Professional 
will say so when they're activated. This message will not appear in screen savers 
created with a registered copy. This message cannot be removed once a screen saver 
has been created – you must re-convert your graphic to SCR with a registered copy of 
Graphic Workshop Professional to banish it.

Note that in addition to converting graphics to the SCR format, Graphic Workshop will 
convert images from its own SCR format back to other, more conventional graphic 
formats. To this end, it can display SCR files in its browser windows. Graphic 
Workshop will only read and convert from SCR files it has created – if you attempt to 
have it read an SCR file from another source, it will most likely display an error 
message. Be warned – if you inquire about why Graphic Workshop displays error 
messages when it's asked to read SCR files it's never heard of, we will, however 
reluctantly, be forced to send a leather-winged demon of the night to search the very 
threads of time for the beating of your heart and breath all over you until your hair falls 
out.

The screen savers created by Graphic Workshop are sixteen-bit Windows applications,
which means that they can be used under Windows 3.1, Windows 95, Windows 98 
and Windows NT. This also means that you will not see an animated preview in the 
Display applet of the Windows Control Panel when you select one, and the Password 
button will be disabled. Password Protection is available for Graphic Workshop's 
screen savers, but it's handled through the Setup dialog.

Graphic Workshop screen savers store their defaults in a file called GWSPSAVE.INI in 
your \WINDOWS directory.

Distribution of screen savers created by Graphic Workshop: If you have 
registered Graphic Workshop Professional, you are welcome to create and distribute 
all the screen savers you like except in a commercial context wherein you are actually 
selling the service of creating screen savers. This assumes that you own the copyright 
to the images they contain, of course. Screen savers created by an unregistered 
evaluation copy of Graphic Workshop may not be distributed.



SFW files – Maximum bits: 24

The SFW format is used for disk-based photographs processed by Seattle Film Works.
Graphic Workshop will read SFW files and convert them to other formats, but it will not 
convert images to SFW files.



SGI files (Silicon Graphics) – Maximum bits: 24

The SGI format is use by Silicon Graphics workstations. Graphic Workshop supports 
most of the format. Specifically, it does not recognize SGI files with obsolete line 
formats. All graphics written to the SGI format will be stored as uncompressed 24-bit 
files, no matter what their source colour depth was. Graphic Workshop also recognizes
files with the extension RGB as being SGI files.



RAS files (Sun raster) – Maximum bits: 24

Sun raster files are native to the Sun unix environment. They can be uncompressed or 
run-length compressed. There are also a number of obscure compression standards 
which Graphic Workshop does not support at present. These rarely turn up – the Get 
Info function will tell you if you've encountered one.

Sun raster files appear with a variety of file extensions. Graphic Workshop uses the 
extension RAS. You might have to rename your files to use this extension if they're 
named something else. Extensions for Sun raster files on a unix system can include
.ras, .rast, .im1, .im8, .im24 and .im32.



TGA files – Maximum bits: 24

The Truevision Targa format is used by several high-end paint programs and things 
like ray-tracing packages. Targa files can also store true colour images with sixteen 
bits of colour, rather than 24, to save space. Enable the Create 16-bit Targa switch in 
Setup to have it do this.



TIFF files – Maximum bits: 24

The TIFF facilities of Graphic Workshop can get a bit involved. The TIFF format offers 
lots of options to make it applicable to a wide variety of applications – which entails a 
certain amount of confusion, as well.

Note that due to the wide variations among the programs which produce TIFF files, 
Graphic Workshop would be lying rather badly if it claimed to be able to read all TIFF 
files. 

Setup includes a field for TIFF Write Options, which allows you to define the type of 
compression to be used in creating TIFF files. Each line in this field has three items, 
specifying the compression type for monochrome files, palette colour files with up to 
eight bits of colour and true colour 24-bit files respectively. The options are:

None No compression
PBits Simple PackBits compression
LZW LZW compression
Group 3 Group 3 FAX compression
Group 4 Group 4 FAX compression
JPEG Lossy JPEG compression
PNG Lossless PNG deflate compression

TIFF files with no compression are fast to read and write, and are all but certain to be 
accepted by any application that reads TIFF files. However, they can result in huge 
disk files. TIFF files with LZW compression take somewhat longer to read and write, 
but they usually result in smaller files. There are many applications which read TIFF 
files but which do not support LZW compression. PackBits compression is somewhere 
in the middle. Group 4 FAX compression can deal with some line drawings more 
effectively than LZW compression can, but it creates files that almost no TIFF readers 
will handle. Don't use Group 4 unless you're certain your target application will read 
them.

JPEG compression is identical to the compression used by the JPG file format – it 
discards a specified amount of image detail to achieve more effective compression. 
The amount of detail to be discarded can be set using the JPEG/FIF/ART Quality 
control in Setup.

PNG compression uses the same compression as is found in the PNG format, the 
PKZIP Deflate compression. Note that while they are legal TIFF compression types, 
JPEG- and PNG-compressed TIFF files are supported by very few other applications 
as of this writing.



TTF files (TrueType fonts) – Maximum bits: 1

TTF files are TrueType fonts. Graphic Workshop will display these as font samples. If 
you convert from TTF to another format, you'll have a bitmapped image with a sample 
of the font. The size of the bitmaps, the example text and other features of the font 
samples can be configured – see the Configuration document. Graphic Workshop will 
not create TTF files.

For a comprehensive TrueType font management package, check out Font Wrangler, 
available at the Alchemy Mindworks web page http://www.mindworkshop.com .



TXT files (text files) - Maximum bits: 24

Graphic Workshop will create a two-colour image from any ASCII text file. It can 
contain both alphabetic characters and high order IBM block graphic characters. Tabs 
are expanded and all other control characters except for carriage returns are ignored. 
Source text files for this function can have up to 2048 lines of text. A line can be up to 
4096 characters wide. If you use files which are longer than this, the extra text will be 
ignored. Note that a text file of these dimensions will create a 130-megabyte bitmap.

Suitable text files must be in pure ASCII, not proprietary word processor documents. 
They must have the extension TXT.



UUE files (uuencoded Internet graphics)

The UUE format isn't a graphic file format at all. Rather, it's a way of graphics and 
other binary objects so they can be sent over text-only electronic mail systems, such 
as Internet e-mail and Usenet newsgroups. The process of uuencoding a graphic turns
it into text – albeit fairly mysterious-looking text – which can be mailed. The received 
uuencoded file must be uudecoded to return it to its former state.

If this means almost nothing to you, you're probably not involved with this aspect of the
Internet and you can safely ignore this section.

Graphic Workshop will read the images from uuencoded text. The file extension for 
your uuencoded text must be UUE. The text itself can contain multiple sections if you 
like – Graphic Workshop will attempt to figure out where the breaks are and assemble 
the original graphic into a correct file.

Graphic Workshop's UUE decoder can work in strict or relaxed mode, as defined by 
the Relaxed UUE option in Setup. This has to do with how it deals with UUE files 
having multiple sections.

In strict mode, the standard begin <mode> <filename>    fields must precede the first 
uuencoded block in your source text file. Each subsequent section for multiple section 
uuencoded files must start with a BEGIN line of some sort and end with an END line. A
uuencoded graphic that appears as multiple sections must have all the sections 
concatenated into a single UUE file. Note that Graphic Workshop does very little 
validity checking for uuencoded data – damaged source data, sections out of 
sequence or incorrectly formed uuencoded headers or trailers may cause Graphic 
Workshop's uudecoder to create an incorrect final binary file and hence a mangled or 
unreadable graphic.

In relaxed mode, Graphic Workshop will decode any line which checks out as valid 
uuencoded data, ignoring all the BEGIN and END markers save for the first one. If it 
doesn't find the END marker of the current file being decoded, it will prompt you for the
next file in the current sequence.

The strict mode guarentees you a correct decode if your UUE files have the correct 
section markers, but not all uuencoded data has these. The relaxed mode can usually 
handle files without headers properly, but some pathological cases will crop up in 
which spurious data is decoded. The strict mode does not prompt for multiple sections 
of a UUE file.



WAV files (Sampled Sound)

WAV files aren't graphics – they're short sound bites. None the less, you can browse 
them with Graphic Workshop. If you "view" one, a small bitmap will appear and the 
sound in the file will play. Note that the Play item in the Picture menu of View mode 
can be used to repeat a WAV file once it finishes. If you attempt to convert a WAV file 
to a graphic format, the resulting graphic file will contain a copy of the WAV bitmap that
appears in View mode.

WAV files display in Graphic Workshop's browser windows with a canned thumbnail.

You must have the MCI sound drivers installed for the WAV functions to work properly. 
These are typically installed as part of Windows 95, 98 and NT 4.0. If the WAV 
functions don't work, you have driver problems.



Windows Wallpaper – Maximum bits: 24

If you select the Wlppr item from the Destination dialog, your selected file will be 
converted to the BMP format and written to your \WINDOWS directory. It will appear on
your desktop as wallpaper. Converting multiple files to Wlppr will cause all the files to 
be written to your \WINDOWS directory, but only the last one will become your current 
wallpaper image. You can change the wallpaper image for your desktop through the 
Windows Control Panel.

Note that 24-bit wallpaper ties up a lot of memory and it won't look very good on 
systems with 16- or 256-colour screen drivers. Consider reducing 24-bit images to 256
colours with the Effects function before you use them as wallpaper.

When you convert an image to wallpaper, you will be prompted to display it centered or
tiled.



WMF files – Maximum bits: 8

The WMF format contains vector graphics. Graphic Workshop will rasterize WMF files 
into bitmaps. You can set the colour depth and approximate image dimensions of the 
rasterized bitmaps this feature will create using the Vector Read Options control in 
Setup. Set the Configuration document for more about this. 

Graphic Workshop will not write to the WMF format.

When you read a WMF file with Graphic Workshop, the result will be a bitmap. Graphic
Workshop will read both conventional and placeable metafiles. If you're curious, you 
can tell which is which through the Get Info function. The Comments field will define 
the number of objects in the file for a conventional metafile and will say "Placeable 
metafile" otherwise.

Note that because the aspect ratio of conventional and placeable metafiles are 
calculated differently, the same drawing stored in both forms will have slightly differing 
dimensions.



WPG files – Maximum bits: 8

These are the native import graphic files for WordPerfect. These files can contain both 
bitmaps and line art, or vector graphics. Graphic Workshop can only deal with the 
bitmapped parts of them. If you view, print or convert a WPG file containing both 
bitmapped and vector elements, the vector elements will be discarded.

WPG files which refuse to read with Graphic Workshop are usually those which 
contain only vector elements and no bitmaps. If you use the Get Info function on
a WPG file which does not read, the comments field of the file information box 
will say "Vector file" if this is the case or you will see a message that says "No 
Bitmap."

Graphic Workshop will deal with WPG files having one, four or eight bits of colour 
information, that is, monochrome files, sixteen-colour files and 256-colour files. 



XBM files – Maximum bits: 1

The XBM format is used to store small bitmaps – it's actually a C-language definition of
a bitmap. XBM files are associated with UNIX systems, wherein they often store icons.



Configuration and Setup

The Graphic Workshop Setup dialog can be accessed by clicking on the Setup button 
in the tool bar or by selecting Setup from the File menu. Because there are a lot of 
format variations and other things you're likely to want to change periodically, you 
should become familiar with Setup.

Setup is organized into a number of panels to make it easier to locate the Setup item 
you need to change.

See the Manual document for information about editing the GWSPRO.INI file.

          The Browser Panel  
          The Display Panel  
          The Files Panel  
          The Formats Panel  
          The Register Panel  



The Browser Panel

Centre Thumbnails: Disable this item to have thumbnail images appear in the upper 
left corner of each thumbnail, or enable it to have them appear in the center of each 
thumbnail.

Close Progress When Complete: Disable this item to always leave the progress 
window open when a batch of files have been processed, or enable it to close the 
progress window unless there have been errors.

Create Thumbnail Options: This is the dithering mode for thumbnails. Remap will 
create contrasty, undithered thumbnails, Bayer will create fairly chunky dithered 
thumbnails and Error-Diffused will create attractive dithered thumbnails. Unless you 
have a compelling reason to do otherwise, use the latter option.

Default Directory Window Size: This is the default width in pixels of the directory tree
when Graphic Workshop creates a new browser window.

Default New Browser Mode: This is the view mode that Graphic Workshop will apply 
to the new browser windows it creates.

Drop Options: This is what Graphic Workshop will do by default when you drop files 
into one of its browser windows. See the Reference document for information about 
overriding the default Drop Options setting.

Include Remote Drives in Browser: Enable this item to include remote network 
drives in the directory tree displays of new browser windows, or disable it to suppress 
them. Note that changes to this item will only apply to windows created or refreshed 
after it's changed. Because it takes significantly longer for Graphic Workshop to survey
network drives than local drives when it creates a browser window, you might want to 
disable this option and use the Folder button to access network drives when you need 
them.

Maximize New Browsers: Enable this item to have Graphic Workshop create new 
browser windows maximized, or disable it to have Graphic Workshop create new 
browser windows at normal size.

Remember Open Windows: Enable this item to have Graphic Workshop remember 
all its open browser windows between sessions.

Untag After Processing: Enable this item to unselect files after processing.

Untag After Viewing: Enable this item to unselect files after viewing.



The Display Panel

Centre Viewed Images: Disable this item to have viewed images appear in the upper 
left corner of View windows, or enable it to have them appear in the center of View 
windows.

Directory Tree Dialogs: Enable this item to have the Change Directory and Move and
Copy dialogs use Windows tree controls, similar to the ones which appear in Graphic 
Workshop's browser windows. Disable this item to use list box controls to select 
directories.

Default View Zoom: This is the default zoom mode for View windows. If it's set to 100 
percent, you graphics will be displayed normally. If it's set to Zoom to Fit, a zoom mode
will be chosen to best fill the View window.

File Menu List Size: This is the maximum number of items that will appear in the 
recently visited directory list in the Graphic Workshop File menu. Set it to zero to 
suppress the list entirely.

Maximize View Windows: Enable this item to have Graphic Workshop create View 
windows maximized, or disable it to have it set them to the dimensions of the graphics 
to be displayed.

Prompt before Viewing Animation: Disable this item to show animations without 
displaying the Select Image dialog, or enable it to display the dialog.

Show Right Click Menu in View: Enable this item to have Graphic Workshop display 
a menu when you right-click in View or Crop mode, or disable it to have it exit View 
and Crop mode when you right-click.

Show Startup Window: Enable this item tohave the startup logo window displayed 
when Graphic Workshop boots up.

Show View Title Path: Enable this item to include the complete paths of the file 
names displays in the caption bars for View and Crop mode, or disable it to just show 
the file names.

View Mode Background: This is the background colour for View mode. Click on this 
colour button to change it.



The Files Panel

Auto Create Thumbnails: Disable this item to suppress the automatic creation of 
thumbnails for new files, or    enable it to create thumbnails whenever new files are 
written by Graphic Workshop.

Default File Extension: This is the default file extension.

File Name Underbars: Enable this item to prepend processed file names with 
underbars, or disable it to use the source name when creating a new name for a 
processed file. This does not apply to files created by the Convert function, which 
always uses source file names. See the Reference document for a discussion of file 
naming for processed files.

Prompt before Moving Files: Enable this item to be prompted before Graphic 
Workshop moves files, or disable it to move files without prompting.

Prompt before Overwriting Files: Enable this item to be prompted before Graphic 
Workshop overwrites files, or disable it overwrite files without prompting.

Prompt for Destination Path: Enable this item to be prompted for a new destination 
directory whenever Graphic Workshop is about to create one or more files, or disable it
to have Graphic Workshop write new files to the source directory.

Prompt for Destination Names: Enable this item to be prompted for a new file name 
whenever Graphic Workshop is about to create a file.

Prompt for File Comments: Enable this item to be prompted for file comments 
whenever Graphic Workshop is about to create a file. The Write File Comments item 
must also be enabled for this item to be recognized.

Use Text File Comments: Enable this item to use text comment files. The Write File 
Comments option must be enabled for this item to be recognized. When Graphic 
Workshop writes file comments and this item is enabled, it will look for a file with the 
same name as the file being written and the file extension specified in the 
TextCommentExtension field in GWSPRO.INI. If a file by this name is found, it will use 
its contents for the file comments about to be written. Text comment files must be pure 
ASCII, not formatted word processor documents.

View Corrupted Files: Enable this item to be prompted to view partial images if a 
corrupt file is read by the View function.

View File Comments: Enable this item to have Graphic Workshop display file 
comments after you exit View mode if any are present.

Write File Comments: Enable this item to have Graphic Workshop write file 
comments to those formats which support them.



The Formats Panel

AVI Quality Factor: The quality factor for writing AVI files should range from 100 for 
unspeakably ugly to 10000 for almost perfect reproduction.

Compress IFF/LBM/PSD Files: Enable this item to compress IFF, LBM and PSD files,
or disable it to create them uncompressed.

Create 16-bit Targa: Enable this item to create sixteen-bit Targa files when writing 
true-colour images to the TGA format, or disable it to create 24-bit Targa files.

Create Compressed EXE Pictures: Disable this item to create uncompressed DOS 
EXE pictures, or Enable it to create compressed DOS EXE pictures.

Create Windows EXE Pictures: Enable this item to create Windows EXE pictures, or 
disable it to create DOS EXE pictures.

Fast FIF Read: Enable this item to buffer FIF files in memory, or disable it to read 
them a block at a time from disk.

JPEG/ART Quality Factor: This control determines the amount of image degradation 
for images written to JPEG and ART files. It should range from 10 for unspeakably ugly
to 100 for almost perfect reproduction.

Password Protect PNG Files: Enable this item to create password-protected PNG 
files, or disable it to create normal PNG files.

Persistent Passwords: Enable this item to preserve your PNG password for the 
duration of your current Graphic Workshop session, or disable it to be prompted for 
your password each time it's required.

Photo-CD Options: This combo box defines which resolution will be requested when 
Graphic Workshop reads a Photo-CD image. The RGB items will cause Graphic 
Workshop to fetch a 24-bit true-colour graphic. The 256-colour items will cause 
Graphic Workshop to fetch an eight-bit dithered graphic. The 256 greys items will 
cause Graphic Workshop to fetch an eight-bit grey-scale graphic. Note that not all 
Photo-CD images have complete resolution sets – if you specify a resolution option 
which is unavailable in the Photo-CD image you ask Graphic Workshop to read, it will 
fetch the closest resolution that does exist.

PNG Compression: The PNG compression factor should range from one for fast 
writes and poor compression to nine for slow writes and more aggressive 
compression.

Rasterize Metafiles to Clipboard: Enable this item to rasterize metafiles to bitmaps 
before they're pasted to the clipboard, or disable it paste them as metafiles.

Read CDR Bitmaps: Enable this item to have Graphic Workshop search CDR files for 
bitmaps, or disable it to always display CDR thumbnails.



Read JPEG/FIF as RGB: Enable this item to have JPEG and FIF files read as 24-bit 
objects, or disable it to have them read as eight-bit objects.

Relaxed UUE: Enable this item for relaxed multiple-block UUE decoding, or disable it 
for strict single-block UUE decoding.

TIFF Write Options: This combo box defines how TIFF files should be written. Each 
item has three sections – one for monochrome images, one for images having 
between four and 256 colours and one for true-colour images. As such, setting it to 
Grp3 – LZW –LZW will cause monochrome images written to TIFF to be stored using 
Group 3 compression and all other files to be stored using LZW compression. See the 
Formats document for a complete discussion of the available TIFF compression types. 
Note that JPEG and PNG compression are legal TIFF options, but few applications 
which read TIFF know how to interpret them.

Vector Options: This combo box defines the size and colour depth of the bitmap used
to rasterize vector files – specifically WMF files.

Write GIF Interlaced: Enable this item to have Graphic Workshop write interlaced GIF
files.

Write MacPaint with headers: Enable this item to add Macbinary headers to 
MacPaint files being create by Graphic Workshop, or disable it to suppress the 
creation of headers.

Write OS/2 Bitmaps: Enable this item to write OS/2 BMP files, or disable it to write 
Windows BMP files. 

Write PBM Headers to IFF/LBM Files: Enable this item to write 256-colour LBM files 
with PBM line structures, or disable it to create them with ILBM line structures.

Write Progressive JPEG: Enable this item to have Graphic Workshop write 
progressive JPEG files, or disable it to have it write conventional JPEG files. Be 
warned – most applications which read JPEG files don't read progressive ones.



Centre Thumbnails: Disable this item to have thumbnail images appear in the upper left 
corner of each thumbnail, or enable it to have them appear in the center of each thumbnail.



Close Progress When Complete: Disable this item to always leave the progress window 
open when a batch of files have been processed, or enable it to close the progress window 
unless there have been errors.



Create Thumbnail Options: This is the dithering mode for thumbnails. Remap will create 
contrasty, undithered thumbnails, Bayer will create fairly chunky dithered thumbnails and 
Error-Diffused will create attractive dithered thumbnails. Unless you have a compelling 
reason to do otherwise, use the latter option.



Default Directory Window Size: This is the default width in pixels of the directory tree 
when Graphic Workshop creates a new browser window.



Default New Browser Mode: This is the view mode that Graphic Workshop will apply to the
new browser windows it creates.



Drop Options: This is what Graphic Workshop will do by default when you drop files into 
one of its browser windows. See the Reference document for information about overriding 
the default Drop Options setting.



Include Remote Drives in Browser: Enable this item to include remote network drives in 
the directory tree displays of new browser windows, or disable it to suppress them. Note that
changes to this item will only apply to windows created or refreshed after it's changed. 
Because it takes significantly longer for Graphic Workshop to survey network drives than 
local drives when it creates a browser window, you might want to disable this option and use
the Folder button to access network drives when you need them.



Maximize New Browsers: Enable this item to have Graphic Workshop create new browser 
windows maximized, or disable it to have Graphic Workshop create new browser windows 
at normal size.



Remember Open Windows: Enable this item to have Graphic Workshop remember all its 
open browser windows between sessions.



Untag After Processing: Enable this item to unselect files after processing.



Untag After Viewing: Enable this item to unselect files after viewing.



Centre Viewed Images: Disable this item to have viewed images appear in the upper left 
corner of View windows, or enable it to have them appear in the center of View windows.



Directory Tree Dialogs: Enable this item to have the Change Directory and Move and Copy
dialogs use Windows tree controls, similar to the ones which appear in Graphic Workshop's 
browser windows. Disable this item to use list box controls to select directories.



Default View Zoom: This is the default zoom mode for View windows. If it's set to 100 
percent, you graphics will be displayed normally. If it's set to Zoom to Fit, a zoom mode will 
be chosen to best fill the View window.



File Menu List Size: This is the maximum number of items that will appear in the recently 
visited directory list in the Graphic Workshop File menu. Set it to zero to suppress the list 
entirely.



Maximize View Windows: Enable this item to have Graphic Workshop create View 
windows maximized, or disable it to have it set them to the dimensions of the graphics to be 
displayed.



Prompt before Viewing Animation: Disable this item to show animations without 
displaying the Select Image dialog, or enable it to display the dialog.



Show Right Click Menu in View: Enable this item to have Graphic Workshop display a 
menu when you right-click in View or Crop mode, or disable it to have it exit View and Crop 
mode when you right-click.



Show Startup Window: Enable this item tohave the startup logo window displayed when 
Graphic Workshop boots up.



Show View Title Path: Enable this item to include the complete paths of the file names 
displays in the caption bars for View and Crop mode, or disable it to just show the file 
names.



View Mode Background: This is the background colour for View mode. Click on this colour 
button to change it.



Auto Create Thumbnails: Disable this item to suppress the automatic creation of 
thumbnails for new files, or    enable it to create thumbnails whenever new files are written 
by Graphic Workshop.



Default File Extension: This is the default file extension.



File Name Underbars: Enable this item to prepend processed file names with underbars, or
disable it to use the source name when creating a new name for a processed file. This does 
not apply to files created by the Convert function, which always uses source file names. See
the Reference document for a discussion of file naming for processed files.



Prompt before Moving Files: Enable this item to be prompted before Graphic Workshop 
moves files, or disable it to move files without prompting.



Prompt before Overwriting Files: Enable this item to be prompted before Graphic 
Workshop overwrites files, or disable it overwrite files without prompting.



Prompt for Destination Path: Enable this item to be prompted for a new destination 
directory whenever Graphic Workshop is about to create one or more files, or disable it to 
have Graphic Workshop write new files to the source directory.



Prompt for Destination Names: Enable this item to be prompted for a new file name 
whenever Graphic Workshop is about to create a file.



Prompt for File Comments: Enable this item to be prompted for file comments whenever 
Graphic Workshop is about to create a file. The Write File Comments item must also be 
enabled for this item to be recognized.



Use Text File Comments: Enable this item to use text comment files. The Write File 
Comments option must be enabled for this item to be recognized. When Graphic Workshop 
writes file comments and this item is enabled, it will look for a file with the same name as the
file being written and the file extension specified in the TextCommentExtension field in 
GWSPRO.INI. If a file by this name is found, it will use its contents for the file comments 
about to be written. Text comment files must be pure ASCII, not formatted word processor 
documents.



View Corrupted Files: Enable this item to be prompted to view partial images if a corrupt 
file is read by the View function.



View File Comments: Enable this item to have Graphic Workshop display file comments 
after you exit View mode if any are present.



Write File Comments: Enable this item to have Graphic Workshop write file comments to 
those formats which support them.



AVI Quality Factor: The quality factor for writing AVI files should range from 100 for 
unspeakably ugly to 10000 for almost perfect reproduction.



Compress IFF/LBM/PSD Files: Enable this item to compress IFF, LBM and PSD files, or 
disable it to create them uncompressed.



Create 16-bit Targa: Enable this item to create sixteen-bit Targa files when writing true-
colour images to the TGA format, or disable it to create 24-bit Targa files.



Create Compressed EXE Pictures: Disable this item to create uncompressed DOS EXE 
pictures, or Enable it to create compressed DOS EXE pictures.



Create Windows EXE Pictures: Enable this item to create Windows EXE pictures, or 
disable it to create DOS EXE pictures.



Fast FIF Read: Enable this item to buffer FIF files in memory, or disable it to read them a 
block at a time from disk.



JPEG/ART Quality Factor: This control determines the amount of image degradation for 
images written to JPEG and ART files. It should range from 10 for unspeakably ugly to 100 
for almost perfect reproduction.



Password Protect PNG Files: Enable this item to create password-protected PNG files, or 
disable it to create normal PNG files.



Persistent Passwords: Enable this item to preserve your PNG password for the duration of
your current Graphic Workshop session, or disable it to be prompted for your password 
each time it's required.



Photo-CD Options: This combo box defines which resolution will be requested when 
Graphic Workshop reads a Photo-CD image. The RGB items will cause Graphic Workshop 
to fetch a 24-bit true-colour graphic. The 256-colour items will cause Graphic Workshop to 
fetch an eight-bit dithered graphic. The 256 greys items will cause Graphic Workshop to 
fetch an eight-bit grey-scale graphic. Note that not all Photo-CD images have complete 
resolution sets – if you specify a resolution option which is unavailable in the Photo-CD 
image you ask Graphic Workshop to read, it will fetch the closest resolution that does exist.



PNG Compression: The PNG compression factor should range from one for fast writes and
poor compression to nine for slow writes and more aggressive compression.



Rasterize Metafiles to Clipboard: Enable this item to rasterize metafiles to bitmaps before 
they're pasted to the clipboard, or disable it paste them as metafiles.



Read CDR Bitmaps: Enable this item to have Graphic Workshop search CDR files for 
bitmaps, or disable it to always display CDR thumbnails.



Read JPEG/FIF as RGB: Enable this item to have JPEG and FIF files read as 24-bit 
objects, or disable it to have them read as eight-bit objects.



Relaxed UUE: Enable this item for relaxed multiple-block UUE decoding, or disable it for 
strict single-block UUE decoding.



TIFF Write Options: This combo box defines how TIFF files should be written. Each item 
has three sections – one for monochrome images, one for images having between four and 
256 colours and one for true-colour images. As such, setting it to Grp3 – LZW –LZW will 
cause monochrome images written to TIFF to be stored using Group 3 compression and all 
other files to be stored using LZW compression. See the Formats document for a complete 
discussion of the available TIFF compression types. Note that JPEG and PNG compression 
are legal TIFF options, but few applications which read TIFF know how to interpret them.



Vector Options: This combo box defines the size and colour depth of the bitmap used to 
rasterize vector files – specifically WMF files.



Write GIF Interlaced: Enable this item to have Graphic Workshop write interlaced GIF files.



Write MacPaint with headers: Enable this item to add Macbinary headers to MacPaint files
being create by Graphic Workshop, or disable it to suppress the creation of headers.



Write OS/2 Bitmaps: Enable this item to write OS/2 BMP files, or disable it to write 
Windows BMP files. 



Write PBM Headers to IFF/LBM Files: Enable this item to write 256-colour LBM files with 
PBM line structures, or disable it to create them with ILBM line structures.



Write Progressive JPEG: Enable this item to have Graphic Workshop write progressive 
JPEG files, or disable it to have it write conventional JPEG files. Be warned – most 
applications which read JPEG files don't read progressive ones.



Registration Code: Your registration code is provided when you register Graphic 
Workshop. If you received Graphic Workshop on an Alchemy Mindworks CD-ROM, it's on 
your invoice in the line item for Graphic Workshop Professional. It will look like this:

Graphic Workshop Pro REG # 12345-12-67890-88 $40.00

If you have received a confirmation e-mail message after registering Graphic Workshop, it 
will appear in this message, like this:

1 Graphic Workshop Pro REG CODE 12345-12-67890-88

Graphic Workshop Professional registration codes are all 17 characters long, in the form of 
one five-digit group of numbers, a dash, one two-digit group of numbers, a dash, a second 
five-digit group on numbers, a dash and a final two-digit group of numbers. You must enter 
your code exactly in the Registration Code field to successfully register Graphic Workshop. 
The dashes separating the digit groups are not entered.

Note: Once it has been entered, your registration code will not be displayed by 
Graphic Workshop. If you have cause to re-install Graphic Workshop in the future, 
you will require your registration name and code. Write them down now and store 
them in a safe place.

Registration Name: Your registration code is a complex checksum based on the characters
of your name. If your name is not entered correctly in the Registration Name field, your 
registration code will not be accepted. Your registration name is printed on your invoice and 
is included in the confirmation e-mail message you received when you registered Graphic 
Workshop. It must be entered exactly – all the characters, spaces and punctuation in your 
registration name as it is provided to you must match what you enter in the Registration 
Name field.



No help is available for this item.



The Register Panel

Registration Code: Your registration code is provided when you register Graphic 
Workshop. If you received Graphic Workshop on an Alchemy Mindworks CD-ROM, it's 
on your invoice in the line item for Graphic Workshop Professional. It will look like this:

Graphic Workshop Pro REG # 12345-12-67890-88 $40.00

If you have received a confirmation e-mail message after registering Graphic 
Workshop, it will appear in this message, like this:

1 Graphic Workshop Pro REG CODE 12345-12-67890-88

Graphic Workshop Professional registration codes are all 17 characters long, in the 
form of one five-digit group of numbers, a dash, one two-digit group of numbers, a 
dash, a second five-digit group on numbers, a dash and a final two-digit group of 
numbers. You must enter your code exactly in the Registration Code field to 
successfully register Graphic Workshop. The dashes separating the digit groups are 
not entered.

Note: Once it has been entered, your registration code will not be displayed by 
Graphic Workshop. If you have cause to re-install Graphic Workshop in the 
future, you will require your registration name and code. Write them down now 
and store them in a safe place.

Registration Name: Your registration code is a complex checksum based on the 
characters of your name. If your name is not entered correctly in the Registration 
Name field, your registration code will not be accepted. Your registration name is 
printed on your invoice and is included in the confirmation e-mail message you 
received when you registered Graphic Workshop. It must be entered exactly – all the 
characters, spaces and punctuation in your registration name as it is provided to you 
must match what you enter in the Registration Name field.



Reference

Graphic Workshop Professional embodies a great deal of functionality for managing 
and manipulating graphic images. It's unlikely that you'll find uses for absolutely 
everything Graphic Workshop knows how to do. It's more unlikely still that you'll want 
to try to learn everything there is to know about Graphic Workshop in a single session.

If you have not already done so, please read the Introduction and Tutorial document 
installed with Graphic Workshop. It will walk you through the basic operation of the 
software and provide you with step by step procedures for performing the most 
common tasks that Graphic Workshop is called upon to do.
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          Selecting Files  
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Caption
The Graphic Workshop Caption function will allow you to add text to existing graphic 
files. Caption text always appears below the graphics it's added to, as it would in 
newspaper captions. The vertical dimension of a captioned graphic will be expanded 
sufficiently to allow for its caption text.

By default, if you have Graphic Workshop caption a file it will create a new file for you 
of the type you select and with "C_" prepended to its name. Thus PICTURE.GIF could 
be written to C_PICTURE.GIF, for example. This option can be disabled in Setup.

To add captions, select one or more files and select Caption from the Image menu. 
The Caption dialog will appear. The following items will affect what your captions look 
like:

Single Line: Enable this option to allow a single line caption – your caption text will
be truncated when it fills the first line or at the first carraige return. Disable this 
option to allow multiple-line captions – your captions will include as many lines as 
they require to display all the caption text.

Background: Click on this colour button to select the colour your caption 
background will be set in. See the discussion of colour in captions, below.

Foreground: Click on this colour button to select the colour your caption text will 
be set in. See the discussion of colour in captions, below.

Frame: Click on this colour button to select the colour your caption frame will be 
set in. See the discussion of colour in captions, below. The frame will only be 
displayed if the Frame Size item is set to a value greater than zero.

Title Font: You can select any alphabetic single-byte TrueType font installed in 
your system as the caption text font.

Title Font Size: This is the point size of the caption text. Bigger point sizes will 
create bigger captions – if you enable the Single Line option, bigger point sizes will 
also allow fewer words in your caption.

Frame Size: Graphic Workshop's Caption function can display a coloured frame 
around your captions. The frame colour is set by the Frame colour button. Set this 
value to zero to disable the creation of a frame.

Justification: Select left, centre or right justifcation for your caption text.

Caption Text: The caption text field will allow you to enter up to 260 characters of 
caption text. You can use carriage returns to format your text if you wish. You can 
also instruct the Caption function to fetch text from a text file. To do this, enter an 
@ character followed by the path to your text file in the Caption Text field. This text 
file must be pure ASCII – not a formatted word processor document file. It can be 
of any length, but keep in mind that really huge files can create really huge 
graphics.



Once a caption has been applied to a graphic, the text in the caption is just pixels – it 
can't be subsequently edited with the Caption function. If you're careful, however, you 
can run the same graphic through Caption multiple times to add multiple captions in 
different colours or different fonts if you like.

Note that the Caption function draws its colours from a standard 256-colour palette. If 
you caption a 24-bit true-colour image, the colours you select will be displayed exactly 
as they appeared in the Caption dialog colour buttons. If you caption a graphic with 
256 or fewer colours, the Foreground, Background and Frame colours you select will 
be matched to the nearest available colours in your graphic. This can result in visible 
colour shifts. If you caption two-colour graphics, make sure you choose colours which 
will remap to black and white correctly.

The Caption function will allow you to add visible captions to your images without 
mangling the pictures in question. Keep in mind that anyone determined to do so can 
subsequently remove them – the Graphic Workshop Crop function, for example, will 
excise captions. There is no practical way to embed text – such as a copyright notice – 
in your graphics in a form which guarantees that someone will not subsequently delete
it.

The Caption button will not be visible if your system is configured with a 640 by 480-
pixel screen driver. You can still access the Caption function through the Image menu.



Catalog

The Graphic Workshop Catalog function will create pictures of your pictures. Tag a 
number of images and select the Cataloging function. One or more files will be 
generated containing thumbnails of your selected images. These can be helpful in 
keeping track of a large collection of picture files.

Files created by the catalog function will be named Catalog00001, Catalog00002, 
Catalog00003 and so on. The catalog function will not overwrite existing files – if the 
file Catalog00001 exists, for example, it will begin with Catalog00002.

When you create a catalog you can select one of a number of sizes for the final 
catalog files, in eight or twenty-four bit colour, with the individual thumbnails set in 
either portrait or landscape frames. Choosing twenty-four bit colour will create more 
attractive catalog images.

If you create eight-bit catalogs you can choose to either remap or dither the thumbnail 
images. As a rule, remapped images won't represent the colours of your source 
graphics all that well and dithered images will lose a bit of resolution. Bayer dithering is
faster than Floyd-Steinberg dithering, but the latter looks better.

Catalog files can be created with a three-dimensional appearance or with a flat white 
or black background. You can select the font to be used for file names – as this text is 
pretty small, it's unwise to use a particularly ornate font.

If you catalog animation files, such as AVI or FLI/FLC, the image cataloged will be the 
first frame in the file.



Clipboard

Graphic Workshop supports the Windows clipboard. Specifically, you can use it to copy
images to the clipboard so other Windows applications can paste them into their 
documents. You can paste images currently on the clipboard into any image file format
which Graphic Workshop supports.

There are two ways to get things onto the clipboard from within Graphic Workshop. To 
get an image from a file to the clipboard:

1. Select the file in question in a browser window.

2. Select Copy from the Edit menu. 

The file will be read and its image copied to the clipboard.

Alternately, you can choose the clipboard, rather than a specific file format,    as the 
destination for any Graphic Workshop function by clicking on the Clpbrd button in the 
Destination dialog. Thus, for example, you could "convert" a GIF files to the clipboard, 
or scale a JPEG file and have the scaled image copied to the clipboard. This would 
cause Graphic Workshop to read the file and write its contents to the clipboard, rather 
than to another disk file.

Note that if you use this function on a vector graphic, the object pasted to the clipboard
will be a metafile, not a bitmap.

To fetch a bitmap from the clipboard and have it written to a file, select Paste from the 
edit menu. You will be prompted for a destination file. You can only Paste with Graphic 
Workshop if the object on the clipboard at the moment is actually a bitmap.



Configure EXE Pictures

Graphic Workshop for Windows can convert images in other graphic file formats, such 
as PCX and GIF, into executable pictures. When you run the executable files so 
created as applications, they'll display the your original images. Graphic Workshop can
create both DOS or Windows applications, as defined by the Windows EXE Pictures 
switch in Setup. If you want to create EXE pictures which can be configured, as 
discussed in this section, the Windows EXE Pictures option must be enabled.

See the EXE section in the Formats document for more about Graphic Workshop's 
DOS-mode EXE pictures.

The Configure EXE Pictures item of the File menu will allow you to configure Windows 
EXE pictures created by Graphic Workshop.

Self-displaying pictures are limited to 256 or fewer colours. If you want to convert an 
image from a true-colour file to an EXE picture – such as a JPEG graphic – you must 
use the Colour Reduction option of the Effects dialog to reduce it to a 256-colour 
graphic, and select EXE as the destination format. Windows EXE pictures created by 
Graphic Workshop are useable as soon as they have been created. They default to 
fairly simple display parameters – you can modify these through the Configure EXE 
Pictures function.

Note: The Configure EXE Pictures function will not open anything other than a 
Windows EXE picture create by Graphic Workshop. If you attempt to open 
another sort of EXE file, such as an application, it will complain.

When an EXE picture has been opened in Configure EXE Pictures, its name will 
appear in the title bar of the Picture Configuration dialog and its dimensions, colour 
depth and the version of Graphic Workshop for Windows that created it will appear in 
the upper left corner of the Picture Configuration application window.

Keep in mind that configuring a Windows EXE picture will change the contents of the 
EXE file for the picture. If you have a virus detector that looks for modified EXE files, 
this will set it off. Doing so is harmless – no viruses have been introduced into your 
pictures.

Here's what the configuration options in Picture Configuration do:

Next Picture
Windows EXE pictures can chain to subsequent    pictures – or, in fact to any other 
application's EXE file – when they terminate. You can use this feature to create a 
Windows slide show. Click on Browse to select the picture to chain to. Delete the 
contents of this field to prevent a picture from chaining.

Note: If you want to abort a sequence of chained Windows EXE pictures 
when they're running, click and hold in the current picture with your right 
mouse button and click on the left button. A dialog will appear to ask if you 
want to abort the sequence.



Effect
Windows EXE pictures have built in multimedia facilities. A Windows EXE picture 
can play wave files, MIDI music files and Video for Windows AVI files. These have 
the file extensions WAV, MID and AVI respectively. You can configure a Windows 
EXE picture to play a multimedia file when it first starts up, or from a menu 
selection or a button in its About box.

Note that colour AVI files will seize the system palette for as long as they play on 
display devices having 256 or fewer colours. This may distort the colours of your 
Windows EXE picture until the movie stops.

You can select an effect file by clicking on Browse. Once an effect has been 
selected, click on Test to see what it sounds or looks like. While an effect is playing 
as a result of clicking on Test, the Test button will become a Stop button. Clicking 
on it will terminate the effect.

When a Windows EXE picture loads, it also looks to its command line for the path 
to a wave, MIDI or AVI file. If it finds one, it will use this as an effect if the Effect 
field has been left blank.

Title
This field allows you to define the text for the title bar of a Windows EXE picture. If 
you leave this field blank, the title will be "Picture."

Message
This field allows you to define the text for the About box of a Windows EXE picture.
It can contain up to 300 characters.

Background and Set Background
If Set Background is enabled, the background of your picture will be the colour 
selected in the matrix of background colour tiles. If it's not enabled, the background
will be the default background colour for the system that runs your EXE pictures. 
The background colour affects the matt around a picture when you maximize it. 
Click in a coloured tile to choose a new background colour. The current colour is 
indicated by a tile with a square within it.

Time Delay
If you enable Time Delay and enter a time delay value, your Windows EXE picture 
will display for a preset time and then automatically terminate or chain to another 
picture.

End On Mouse
If the End On Mouse option is enabled, clicking in a Windows EXE picture with 
your mouse will cause it to terminate or chain to another picture. This does not 
affect using the right mouse button to terminate a sequence of chained pictures.

Start With Effect
If the Start With Effect option is enabled, your Windows EXE picture will play an 
effect defined as soon as it runs if one was defined.

No Title Bar



The No Title Bar option will disable the title bar, system menu and the minimize and
maximize buttons of a Windows EXE picture. It will only be enabled if End On 
Mouse or Time Delay are selected, such that there is some way to terminate your 
picture.

Centre Picture
The Centre Picture option will place your picture in the centre of its window when 
the window is maximized. If this option is not enabled the picture will appear in the 
upper left corner.

Maximize
The Maximize option will cause a Windows EXE picture to maximize automatically 
when it runs.

An unmaximized Windows EXE picture will generate a window just large enough to
contain it. If you attempt to display a picture larger than your screen, Windows may
be unable to create a window for it, and the image will not display. It's a good idea 
to keep the sizes of your Windows EXE pictures to modest dimensions.

EXE pictures created with an unregistered copy of Graphic Workshop Professional will 
say so when they're run. This message will not appear in EXE pictures created with a 
registered copy. This message cannot be removed once an EXE picture has been 
created – you must re-convert your graphic to EXE with a registered copy of Graphic 
Workshop Professional to banish it.

Distribution of EXE pictures created by Graphic Workshop: If you have registered 
Graphic Workshop Professional, you are welcome to create and distribute all the EXE 
pictures you like except in a commercial context wherein you are actually selling the 
service of creating EXE pictures. This assumes that you own the copyright to the 
images they contain, of course. EXE pictures created by an unregistered evaluation 
copy of Graphic Workshop may not be distributed.



Convert

Graphic Workshop will allow you to convert file of any format into files of any other 
format – with a few restrictions. The new file will have the same name as the original 
but a new extension. Converting PICTURE.GIF into a PCX file, for example, will create
PICTURE.PCX. PICTURE.GIF will not be affected.

You can batch-convert any mixture of file types using Graphic Workshop. Any files 
which are inappropriate for the conversion you've requested will be ignored. The 
ongoing status will appear in the progress window.

You cannot convert pictures having more bits of colour than the destination format can 
handle. For example, you cannot convert a 24-bit JPEG file directly to an 8-bit GIF file. 
You should have to use the Effects colour-reduction facility to do this. Likewise, use    
the Dither function to convert a colour file to a format which only accepts monochrome 
images.

You can convert between selected animated formats. You can also convert from an 
animated format to a still format – a dialog will appear allowing you to select the frame 
to convert. You can't convert from a still format to an animated format.

Note that Graphic Workshop will not convert between AVI and animated GIF files. See 
our GIF Construction Set software for this functionality. It's available at our web page, 
http://www.mindworkshop.com.

Not all the formats supported by Graphic Workshop are writeable. For example, you 
can convert from Photo-CD to JPEG, but not from JPEG to Photo-CD because Kodak 
wants serious bucks for its Photo-CD mastering software. Formats which cannot be 
written to do not appear in the Destination dialog.

If the format you want to convert a file to is disabled in the Destination dialog, one of 
two things has happened:

- You are attempting to save an image to a format that doesn't support enough colours 
to store it.

- The format in question has been switched off in the Formats dialog. Select Formats 
from the File menu of Graphic Workshop to re-enable it.

If you convert a file and select Clpbrd as its destination format, it will be pasted to the 
Windows clipboard and no actual destination file will be created. This is equivalent to 
selecting a file and selecting Copy from the Edit menu. If you convert a file to WllPpr, it 
will be converted to a BMP file, written to your \WINDOWS directory and configured as 
your current wallpaper image.



Crop

The crop function will allow you to select areas of an image by dragging a rectangle 
around the bits you like with your mouse. Select Save As from the Picture menu to 
save the selected fragment to a new file. The Crop window may scale the image being 
cropped to fit in the window – cropped fragments will be written correctly.

You can fine-tune the cropping rectangle with the arrow keys of your keyboard. Hold 
down the left Shift key and use the arrow keys to move the left and top sides. Hold 
down the right Shift key and use the arrow keys to move the right and bottom sides. 
Use the arrow keys by themselves to move the rectangle.

If your source image has more colours than your Windows driver can display directly, 
you'll see a dithered approximation of your picture in the cropping window. Any 
fragments cropped from it will be saved with their original colour depth, however.

The title bar of a Crop window will display the location of your mouse cursor relative to 
the upper left corner of the image you're cropping and the dimensions of the cropping 
rectangle if one is visible.



Delete

You can delete one or more files in a Graphic Workshop browser window by selecting 
each file to be deleted and then clicking on the Delete button, or selecting Delete from 
the file menu. A dialog will appear prompting you to confirm that you want to delete the 
selected files. Note that it will tell you how many files it proposes to delete. Make sure 
this number corresponds with the files you think you selected – it's not uncommon in 
working with large directories of files to have selected a few earlier and subsequently 
forgotten about them.

The Delete function can delete files in two ways:

- It can remove them from your hard drive. Files thus deleted are gone for good and 
they cannot be subsequently recovered. 

- It can send them to the Windows recycle bin. If you send files to the recycle bin and 
subsequently change your mind about their general unworthiness to continue existing, 
you can drag them back into a directory on your hard drive. The catch in using the 
recycle bin is that most graphic files are uncommonly large, and it's not at all difficult to
tie up a lot of hard drive space by sending them to the recycle bin if you don't keep an 
eye on them. If you have the Recycle Bin option in the file deletion dialog enabled, 
make sure you empty your recycle bin frequently.



Dither

Dithering is a sort of magical process by which colour images can be converted into 
pretty attractive black and white versions for reproduction on a monochrome screen or 
a black and white laser printer. 

Note that source files for dithering must have more than two colours. 

Dithering often works a lot better if you scale the original image up. Graphic Workshop 
lets you dither with images of anywhere from "size as" up to 500 percent expansion.

Note that the Dither function only dithers to monochrome. Colour dithering is handled 
by the Effects function.

By default, if you have Graphic Workshop dither a file it will create a new file for you of 
the type you select and with "D_" prepended to its name. Thus PICTURE.GIF could be
written to D_PICTURE.GIF, for example. This option can be disabled in Setup.

The simplest and fastest form of dithering is Bayer dithering. This does not produce 
great results, but it's extremely quick. 

The remaining three dithering algorithms use what's called "error diffusion." These 
produce attractive dithers, but they're quite slow if they're applied to really large 
graphics. The fastest and least attractive is Floyd-Steinberg. The best and by far the 
slowest is Stucki. The Burkes dither is somewhere in the middle.

All three of these dithers come in two flavours, unidirectional and bidirectional. These 
options will produce slightly different results.

You should plan to experiment with the dithering options of Graphic Workshop a bit to 
see what it's capable of.

In dithering an image, the original brightness levels of the source graphic will be 
expanded a bit to improve the quality of the dither. The amount by which the grey 
levels are expanded is set by the Brightness and Contrast items in the Dither Options 
dialog. 

In addition to true dithering, the Dither function also provides for thresholding. This will 
reduce a colour or grey scale image to black and white by setting a white threshold. 
The results will usually be an exceedingly contrasty image. The higher you set the 
threshold value, the darker your new image will become. The threshold is point below 
which pixels in the source image will be considered to be black in the destination 
image.



Drag and Drop

You can Drag files into any Graphic Workshop browser window from Windows 
Explorer and other file drag sources. You can also drag selected files from a Graphic 
Workshop browser window to other applications which are Drag and Drop compliant, 
such as WinZIP. Finally, you can drag selected files between Graphic Workshop's 
browser windows. Note that you cannot drag files from Graphic Workshop to 
some versions of Windows Explorer, for reasons which Windows Explorer 
declines to explain.

By default, files dropped into a Graphic Workshop browser window will be copied to 
the directory it's looking at. Alternately, you can configure the default drop action in 
Setup to be:

Copy
Move
View
Prompt for one of the above.

Note that the Move function will delete the source files being dropped into a Graphic 
Workshop browser window once they have been copied.

If you hold down the Shift key when you drop files into a Graphic Workshop browser 
window, you will be prompted for a drop function no matter how you've configured 
Graphic Workshop. If you hold down the Ctrl key when you drop files into a Graphic 
Workshop browser window, the files will be moved function no matter how you've 
configured Graphic Workshop.

You can configure Graphic Workshop to prompt you before overwriting files through 
Setup. 

Note that Graphic Workshop will only allow you to drop files into its browser windows if 
they're of types it recognizes.



Effects

The Effects function does colour reduction, remapping, dithering, conversion to grey 
scale, softening, sharpening and promotion to true colour. For a more extensive library 
of graphic effects, see the Filters option in the Picture menu of View mode.

By default, if you have Graphic Workshop apply effects to a file it will create a new file 
for you of the type you select and with "X_" prepended to its name. Thus 
PICTURE.GIF could be written to X_PICTURE.GIF, for example. This option can be 
disabled in Setup.

Colour reduction
The colour reduction function will create destination files with fewer colours than 
the source files they're derived from. You can use this function, for example, to 
reduce a 256-colour file down to a 16-colour one. It's particularly useful for 24-bit 
true-colour files to 256-colour files.

This is the function to use if you want to convert JPEG to GIF.

Whenever you reduce the number of colours in a graphic, some image information 
will get lost. The simplest form of colour reduction is "remapping". This means that 
the destination image will have the best colour palette it can, and that all the pixels 
in it will be replaced with colours from that palette. The results usually aren't very 
attractive.

Colour dithering can produce decidedly better results. With colour dithering you 
can reduce 24-bit files down to eight bits with very little loss of detail or colour 
resolution.

Colour dithering can work to either a quantized or a fixed palette. A quantized 
palette is one which is selected from the image itself. A fixed palette is one which is
the same for all images. Colour reduction to a quantized palette is typically a lot 
more attractive.

The sixteen-colour fixed Windows palette should be used to create images which 
are to be used in a sixteen-colour Windows environment. Note that a lot of image 
quality will be lost in dithering to sixteen colours. The Graphic Workshop colour 
dithering functions have been fine tuned to improve the image quality when 
dithering to the fixed Windows palette. Specifically, the Floyd-Steinberg option will 
result in more attractive results for images with a lot of continuous tones – pictures 
of people, for example – while the Burkes and Stucki options will look better for 
images with larger areas of solid colour.

The 240 plus 16-colour palette consists of a 240-colour quantized palette followed 
by the sixteen-colour Windows fixed palette. If you select this option, your image 
will only be dithered or remapped to the first 240 colours.

The Custom palette option will allow you to choose the palette with which colour 
reduction or dithering will be performed. Click on the Select button and select a 
graphic file which contains the palette you'd like to use as the destination palette 



for your dithered or remapped graphics. Note that this selected file won't be altered
– it will just be read as the source of a palette. The source palette file can be in any
graphic file format supported by Graphic Workshop, but it must contain between 
four and 256 colours. Use the Get Info function to ascertain the number of colours 
in a file.

Grey scale
The grey scale function will create a grey scale destination image from a colour 
source image.

Sharpen
The sharpen function will create a destination image with more finely resolved 
details than its source image.

Soften
The soften function will create a destination image with less finely resolved details 
than its source image.

Smudge
The smudge function will create a destination image which looks like it's being 
viewed through water drops.

Spatial Posterization
The spatial posterization function will create a destination image in which the 
image is made up of large square tiles.

Promote to 24 Bits
The promote to 24 bits function will create a 24-bit file with the same image 
information as a source image having fewer colours. 



Formats

You can disable selected file formats in Graphic Workshop. When a format is disabled,
no files of that type will appear in the Graphic Workshop file selector. Disabled formats 
can subsequently be re-enabled whenever you like. To enable or disable formats, 
select the Formats item from the File menu of Graphic Workshop. Click on the formats 
you wish to enable or disable. Enabled formats have an X beside them.



Get Information

If you select a file in one of Graphic Workshop's browser windows and click on the Get 
Info button or select Get Info from the Image menu, a dialog will appear to tell you 
about the file. The important things you'll probably want to know are the pixel 
dimensions and the colour depth of the image in your file. This can be handy, for 
example, if you want to ascertain whether a particular graphic will fit on your web page 
without having to be scaled down.

Get Information will tell you the following things:

- The dimensions of your graphic in pixels.

- The colour depth of your graphic, that is, the maximum number of colours it can 

- support. This doesn't mean that it necessarily uses them all.

- The packed size, that is, the number of bytes your graphic occupies as a disk file.

- The unpacked size, that is, the amount of memory required to open it or process it.

- The file type – which you probably already know, based on the file extension.

- The amount of compression afforded by whichever file format the file is stored in. 
This number is somewhat meaningless for animation files.

- Comments, which will vary between formats.

Some graphic file formats actually contain a lot more information than can be 
displayed in the normal File Information dialog. TIFF files, for example, can contain the
name of the artist responsible for them, the type of software used to create them and 
so on. You can get at this optional information for formats which support it by clicking 
on the Details button in the File Information dialog if it's enabled

You may need some external assistance in fully interpreting the details of the more 
complex formats, such as TIFF. 

The File Information dialog will display a palette which represents the colours in your 
graphic. For true colour images, this will be a rainbow of colours ranging between 
black and white.

If you request file information for a graphic which has a Graphic Workshop thumbnail 
available, the thumbnail and its key words and comments will also appear in the File 
Information dialog.



GrafCat – Printed Graphic Catalogs

The GrafCat function will print high-resolution thumbnail pages with between six and 
48 pictures per page. It's analogous to creating catalog images with the Catalog 
function and then printing them, save that it does so more conveniently and produces 
vastly more attractive results. The GrafCat function of Graphic Workshop Professional 
features a subset of the functionality of Alchemy Mindworks' stand-alone GrafCat 
software.

The GrafCat Options dialog includes the following controls:

Portrait mode frames, 16 per page: Causes your pictures to be printed sixteen to
a page, with each image inset in a portrait mode frame.

Landscape mode frames, 15 per page: Causes your pictures to be printed fifteen
to a page, with each image inset in a landscape mode frame. This mode will leave 
a blank left margin, allowing your pages to be bound.

Large squares, 6 per page: Causes your pictures to be printed six to a page, with 
each image inset in a square frame.

Small squares, 48 per page: Causes your pictures to be printed 48 to a page, 
with each image inset in a square frame. This mode will get the greatest number of
images on a single page.

Two-Colour Dithered: This mode will cause your graphics to be dithered to two 
colours prior to printing. This will result in the nicest looking printed pages if you're 
using a dot-matrix printer.

256-level grey scale: This mode will cause your graphics to be printed as 256-
level grey scale images, to be halftoned by your Windows printer driver. This mode 
will look dreadful if you have a Windows printer driver that doesn't do halftoning.

24-bit true colour: This mode should be used if you will be printing to a colour 
output device.

PrintBrighteness and PrintContrast: Adjust these values if you're using a black 
and white printer and find that your output is too dark or too flat respectively. This 
value only affects black and white printers.

DitherBrighteness and DitherContrast: Adjust these values if you're using the 
dithered monochrome printing option and the brightness or contrast of your printed 
pictures isn't correct. This value only affects printing in the Dithered Monochrome 
mode.

Matt Colour: This colour button will let you set the colour of the area inside each 
GrafCat frame which is not occupied by the image it contains.

Title Font: This combo box will let you select the font to be used to print the file 
names and titles on your pages.



Page Footer: This field will allow you to customize the text for the printed footer for
each page. You can enter any text you like here, as well as the following macro 
symbols:

%P:    page number
%D: date
%T: time
%S: time and date
%N: registered name
%A: program name
%V: volume name
%%: percent sign

These symbols will be replaced by the entities they represent wherever they 
appear in your footer text. So, for example, if your footer text is entered like this:

Page %P printed by %A registered to %N

it would print something like this:

Page 6 printed by Graphic Workshop Professional registered to Lancelot 
Pigswallow

This assumes, of course, that your name is Lancelot Pigswallow -- in which case 
you have a lot more important things to worry about than the GrafCat footer text.

Note: When it's confronted with one of GrafCat's complex pages, Windows can 
generate some fairly huge temporary files. Printing to a high resolution colour printer 
can require upwards of ten megabytes of free disk space per page for temporary files. 
Printing to a PostScript laser printer can result in temporary files of excess of 25 
megabytes per page. If your pages refuse to print, free up some additional hard drive 
space.



Identify Mystery Graphic Files

In order to deal with directories of graphic files reasonably quickly, Graphic Workshop 
makes the initial assumption that all the files it's asked to handle will have correct file 
extensions. For example, it assumes that JPEG files will have the extension JPG. A 
JPEG file with the extension GIF would not be readable.

In some cases – especially if you like to download graphics from the internet – you 
might encounter files which have obviously incorrect extensions, mysterious 
extensions or no extensions at all. You might also encounter files which Graphic 
Workshop can't read even though you're fairly sure that they're valid graphics – this is 
a good indication that the files in question have incorrect extensions.

Note that web browsers, such as Internet Explorer and Netscape, display the graphic 
files they support irregardless of their extensions. They can do this because they 
typically support fewer than half a dozen graphic formats. This can be a source of 
considerable confusion if your browser displays a file which purports to be a JPG 
graphic, for example, and Graphic Workshop will not. It's probably a file of another type
which has been renamed with the JPG extension.

The Identify Mystery Files function in the File menu of Graphic Workshop will attempt 
to figure out the true nature of mysterious files. Specifically, it will compare the internal 
structure of a file of unknown type to the internal structures it knows how to deal with. If
it finds a match, it will advise you of this and offer you the option of having the file in 
question renamed with its correct extension. It will thereafter be viewable by Graphic 
Workshop.

This process is mildly fraught with perils. It's possible to create files which will 
look like valid image structures, but which actually contain nothing but monkey 
dandruff. If you attempt to identify such a file, Graphic Workshop may 
erroneously tell you that it's something it isn't. Once Graphic Workshop tells you
what a mystery file is, it's a very good idea to view it and make sure it's not 
pulling your leg.

Secondly, Graphic Workshop can only identify a subset of the file types it 
actually knows how to interpret. It won't do anything with mystery files in 
formats it doesn't recognize. It will also prove to be unable to recognize files in 
some of its supported formats if the formats in question don't actually have 
identifiable internal structures. For example, there's no reliable way to 
determine whether a mystery file is actually a MacPaint image because 
MacPaint files don't include identifiable structures. Graphic Workshop will not 
check mystery files to see if they're MacPaint files. 

For the most part, the formats that Graphic Workshop will read but doesn't 
check are fairly obscure ones.



Moving and Copying Files

The Move and Copy Files function will copy files to another drive or directory, 
optionally deleting your source files when it's done. Specifically, Copy will copy files 
and leave your source files in place. Move will copy files and then delete your source 
files. In the latter case you'll be prompted to allow it to do so. The Move and Copy Files
function includes optional verification of the copied files using a 32-bit CRC check. This
reduces the likelihood of incorrectly copied files to something less than the odds of 
winning a state-run lottery.

Turn on the Prompt Before Overwrite option in Setup to prevent Move and Copy from 
overwriting existing files.

You can disable the prompt before moving files by turning off Prompt Before Moving 
Files in Setup.



Print

You can print one or more graphic files by selecting them in a browser window and 
clicking on the Print button, or by selecting Print from the Image menu.

Graphic Workshop's printing facilities will be determined by the printing capabilities of 
your currently selected printer and printer driver. It will print in colour, print to unusual 
output devices and so on if you have an appropriate driver installed in Windows. 

You can select the current printer by clicking on the Setup button of the Print Options    
dialog. 

Printing can be handled using either Integral sizes or Scaled sizes. These work as 
follows:

Print at Integral Sizes: The Autosize option in the Print box will select one of the 
eight size options to best fill your page. Note that this will choose the best integral 
expansion factor – it will not scale your images arbitrarily to fill your page, as this 
could introduce scaling aberrations into them. The Integral Printing option will 
usually give you the best print quality, but not the best fit to your page.

Print with Scaling: The Scale to Fill the Page option will automatically size your 
printed image to fill the printable area of your page in one dimension. This will not 
include any printer margins. If this item is not selected, the printing size will be 
determined by the Scale Factor control – setting this value to 100 will print your 
graphic at precisely one pixel of your image to one pixel of your printer. This is 
usually very small. Setting it to 200 will double the size. Setting it to 50 will print at 
half size, a handy feature for creating your own postage stamps. The Print with 
Scaling option may introduce scaling aberrations into your graphics.

Note: in order to print correctly to some black and white laser printers, colour and grey 
scale images must be "expanded," that is, their grey scales must be adjusted to 
compensate for the non-linear grey scale of the output device. The amount of 
compensation varies among different laser printers. You can set it using the brightness 
and contrast controls in the Print dialog. The Expand Printed Halftones option must be 
enabled to do this.

The Center Printed Images item will center your pictures on the pages they're printed 
to.

Graphic Workshop will print in landscape or portrait mode – use the Setup button in the
Print Options dialog to select the printer characteristics you require.

Graphic Workshop will optionally print a title for each file along with its image. You can 
specify the font you'd like it to use through the Title Font combo box in the Print 
Options dialog and the point size of the font to be used with the Font Size control.

The titles printed by Graphic Workshop can consist of text you supply and several 
macros. Enter your title text in the Title Text field. The macros expand to the name of 
your file, the date it was printed and so on, as follows:



%P: File path
%F: File name
%D: Printing date
%T: Printing time
%S: Printing time and date
%N: User name
%A: Application name
%%: Percent sign

You can enter up to 260 characters of text in the title field. Your final title may be longer
than this due to macro expansion.

Here are some example titles and the text they will cause to be printed – these assume
that you're printing EXAMPLE3.JPG and your name is Lancelot Pigswallow. Should 
the latter be the case, you have our sympathy.

%F EXAMPLE3.JPG
This is %F This is EXAMPLE3.JPG
This is %F by %N This is EXAMPLE3.JPG by Lancelot Pigswallow

You can specify the background colour for printed graphics with the Page Colour 
button in the Print Options dialog. Selecting a coloured background when you're 
printing to a black and white printer will print with a grey level. Keep in mind that if you 
select a fairly dark background, your printer will get through a lot of toner or ink.

Note that Graphic Workshop stores information about your printer in a file called 
PDEVMODE.BIN in the Graphic Workshop parent directory. Deleting this file with 
Graphic Workshop not running will restore your printer defaults. You may find this is 
necessary if you install a new printer.



Rename

You can rename one or more files in a Graphic Workshop browser window by selecting
each file to be renamed and then clicking on the Rename button, or selecting Rename 
from the file menu. The Rename function will prompt you for a new name for each 
selected file. If you attempt to enter a new name which contains characters that are not
legal in file names, it will omit the errant characters.

Note that you cannot use the Rename function to change the file extension of an 
image file. If you were to attempt to rename EXAMPLE3.JPG to 
FlyingPurpleWombats.BMP, the renamed file would in fact be called 
FlyingPurpleWombats.JPG.

It's also worth noting that space characters are legal in Windows file names. As such, 
you could rename a file to Flying Purple Wombats.JPG.



Reverse

The reverse function will create a reversed version of any image file. 

By default, if you have Graphic Workshop reverse a file it will create a new file for you 
of the type you select and with "R_" prepended to its name. Thus PICTURE.GIF could 
be written to R_PICTURE.GIF, for example. This option can be disabled in Setup.

If you reverse a colour image, Graphic Workshop will create a colour negative. These 
look weird – we haven't found a use for them as yet.



Scale

The Scale function will allow you to scale files up or down by percentage, or to specific
sizes. Select By Factor to scale files by a percentage or By Size to scale pictures to 
the dimensions of your choice.

By default, if you have Graphic Workshop scale a file it will create a new file for you of 
the type you select and with "S_" prepended to its name. Thus PICTURE.GIF could be
written to S_PICTURE.GIF, for example. This option can be disabled in Setup.

In pathological cases scaling a picture can produce some really ugly results, 
depending on what you scale. Bear in mind that scaling by integral values – down to 
seventy five or fifty percent, up to two hundred percent and so on – will produce less 
ugly results than scaling by arbitrary values.

The scaling values you enter will be rounded to the nearest lower integral value. Thus, 
42.5 percent will really be 42 percent.

You should avoid scaling dithered monochrome pictures. Nothing technically bad will 
happen, but for reasons which will become obvious if you think about it, the results will 
almost always be horrible enough to mutate bacteria.

Note that the scaling percentage you enter determines the size of the destination 
image relative to the source image. Thus, entering 25 will produce a destination image 
which has dimensions one quarter – 25 percent – of the original image. Entering 200 
will create a destination image twice as big – 200 percent – of the original. Entering 
100 will produce a destination image identical to the source image.

By default, scaling by factors will be the same in both dimensions. If you select the 
Anamorphic option you'll be able to enter independent horizontal and vertical values.

You can also scale pictures to a specific size. If you select the By Size option and then 
enter dimensions in pixels into the Dimensions fields, Graphic Workshop will calculate 
the appropriate scaling factors to make you pictures come out to the size you've 
selected.

The fixed size buttons in the By Size group will allow you to quickly select commonly 
used image sizes. They set the Dimensions fields to their indicated values.

The Maintain Aspect option will allow you to scale to a fixed size image without 
changing the aspect ratio of your graphics. It will cause your image to be scaled such 
that one dimension fills the indicated frame and the other dimension is scaled by the 
same factor. For example, if you were to scale a 320 by 200 picture to 800 by 600 with 
this option enabled, the resulting image would be 800 by 500 pixels. The longest 
dimension, 320, would be scaled to 800 pixels. The shortest dimension, 200, would 
scaled by the same factor as the longest dimension.

The minimum size for scaling by size 16 pixels. 

The Interpolated / Integrated Scaling option will cause Graphic Workshop to apply 



some image processing to scaled images if it's enabled. It only works for true-colour 
and grey-scale graphics – it will be ignored if you attempt to scale a monochrome or 
palette image.

When you scale a graphic up, its pixels are in a sense moved apart and additional 
pixels are generated to fill the gaps between them. This can be handled in one of two 
ways. The simplest one – and by far the fastest – is to duplicate the existing pixels in 
the source image to fill the gaps. This can result in a final graphic which looks like a 
Roman mosaic, with a small number of large, visible pixels.

The second approach to scaling a picture up is to generate the required new pixels as 
a smooth transition between the existing pixels. This is called "interpolation" or "anti-
aliased scaling." The results are much more attractive, but they take longer to achieve.

Having said this, for graphics of moderate size and a fast computer, the difference in 
processing time will be significantly less than that required to read the foregoing 
paragraphs and realize that a difference exists at all.

In scaling a graphic down, some of the pixels in the source image have to be removed,
and hence some of the detail will be lost. As with scaling up, this can be handled in 
one of two ways. Graphic Workshop can just remove the required pixels and send 
them into the eleventh dimension, or it can average all the pixels to be removed to 
generate the new pixels for the scaled-down image. The first case is faster, while the 
second one typically looks a lot better. Averaging the source pixels is called 
"integration", or, once again, "anti-aliased scaling."

Interpolated / integrated scaling is a usually two-pass process – you'll see the status 
bar move twice for each image being scaled. It also requires lots of memory, and 
unlike conventional scaling, its memory requirements increase with the final size of 
your scaled image. If you use interpolated / integrated scaling to scale large pictures 
up to make still larger pictures, Windows might have to do a lot of internal memory 
management. This can often take a long time and result in considerable hard disk 
activity. Be patient.

Note that if you promote a palette-colour image to 24 bits or convert it to a grey-scale 
image and then run it through interpolated / integrated scaling, some really peculiar 
image artifacts will probably appear in the final scaled graphic.

Should you want to create thumbnail graphics for a web page, the Graphic Workshop 
scaling function is the place to be. Here's how to do it:

1. Select your source images and select the Scaling function. 

2. Select the By Size option in the Scaling dialog.

3. Enter rectangular dimensions for the frame in which you'd like all your 
thumbnails to reside. If you enter 96 by 96, for example, Graphic Workshop will 
create thumbnails of the same dimensions as the ones it displays in its browser 
windows.

4. Click on OK and select JPG as the destination format.



You might want to switch off the File Name Underbars option in Setup and write your 
thumbnail JPG files to a different directory to keep the names constant.



Scanning

Graphic Workshop can acquire images through a TWAIN device. The TWAIN interface 
is typically used by scanners, but it's also applicable to digital cameras and other 
image generators with TWAIN drivers. Note that your system must have suitable 
TWAIN drivers installed for your scanner to use the Acquire function of Graphic 
Workshop – scanners which are not TWAIN-compliant are not supported by the 
software.

If the Acquire function in Graphic Workshop is disabled, your TWAIN driver could not 
be located.

Note: A few scanners have semi-compliant TWAIN interfaces which Graphic Workshop
does not get along with. If you can't scan through Graphic Workshop's Acquire 
function, check your scanner setup. Failing this, contact your scanner manufacturer to 
see if there's an updated driver set available.

To scan a graphic using Graphic Workshop, click on the Acquire button or select 
Acquire from the Image menu. A dialog will appear to drive your scanner.

The Acquire dialog is resident in your TWAIN driver and is not part of Graphic 
Workshop. Its contents will vary with the capability of your scanner. Consult your 
scanner documentation for a discussion of its use. It will also probably look 
cosmetically different from the rest of Graphic Workshop.

When you have completed a scan, Graphic Workshop will prompt you for a destination
format and a file name to save it to.

Graphic Workshop accepts the images your scanner created and writes them to files 
with no correction or modification. Some TWAIN drivers offer options that can be used 
to create pretty ugly images. This is especially true of what purport to be 256-colour 
scanning modes. If you want to scan graphics and wind up with 256-colour image files 
– such as to write your pictures to GIF files – you should scan into 24-bit true-colour 
files and then use the colour reduction features of Graphic Workshop's Effects function
to reduce your source images to 256 colours.

When Graphic Workshop boots up, it looks for a TWAIN_32.DLL to load as its TWAIN 
driver. It must reside in \WINDOWS, in \WINDOWS\SYSTEM or in Graphic 
Workshop's parent directory for it to be located.

Note that many TWAIN drivers hang pretty reliably if you attempt to scan something 
with your scanner switched off. This will usually require that you reboot your system to 
re-initialize the driver.

If you have multiple TWAIN devices in your system, you can choose the one you want 
to scan with by selecting Select Source from the Image menu or by holding down the 
Shift key and clicking on the Acquire button.

Note that Graphic Workshop does not use virtual memory to scan. If you want to scan 
a twelve-megabyte image, your system must have at least twelve megabytes of 



available physical memory.



Screen Capture

Graphic Workshop Professional Camera is an ancillary application to capture all or part
of a Windows screen to a PCX file. You can capture the entire screen, the currently 
active window or just the client area thereof. The PCX files created by Camera can be 
converted to any other format you like using Graphic Workshop itself.

When it's running, Camera will capture screens in response to a predefined 
combination of keys. You can choose the activation key combination from a list of key 
combinations.

To get Camera ready to capture screens, run it from its desktop shortcut icon or from 
the listing in the Programs section of your Start menu. You can configure it by double 
clicking on its task bar icon.

Here's what the items in the Setup dialog do:

File Path and Base Capture File Name: These items define the directory where 
your screen capture files will be written, and    the file name to be used to store 
them. The file names will have sequence numbers appended to them. As such, if 
the File Path is set to C:\GraphicWorkshopProfessional and the Base Capture 
File Name is set to Capture, the first time you invoke Camera to capture a screen, 
a file called Capture00001.PCX will be created in the directory C:\
GraphicWorkshopProfessional. The next time you ask Camera to capture a 
screen the file will be called Capture00002.PCX, and so on.

Camera checks each potential file name before it uses it. As such, it will not 
overwrite existing files. The file numbers can range from one through 32767 – 
although if the file number gets anywhere near this large, you should plan on a 
fairly lengthy wait between captures. You'll probably also need a few extra 
gigabytes of hard drive space to hold all the files.

If the Auto Create Thumbnail switch in the Graphic Workshop Professional Setup 
dialog is enabled, Camera will create thumbnails for the images it writes.

Alternate PCX Files: This item defines how sixteen-colour screen capture PCX 
files should be written. This will only matter if you're using a sixteen-colour 
Windows screen driver – happily there are few of these left in captivity. If you 
enable this item, sixteen-colour PCX files will be written in a format which is faster 
for some Windows applications to unpack, but which are not compatible with most 
DOS applications that read PCX files. If you have a Windows screen driver made 
after the late middle ages, you can ignore this setting.

Window to Capture: This item selects the area of your screen for Camera to 
capture. If you select Whole Screen, the whole screen will be captured – perhaps 
not surprisingly. Active Window will cause Camera to capture the topmost window 
on your screen. Active Client will cause Camera to capture the client area of the 
topmost window. Note that Camera will complain if you use one of the latter two 
options and the topmost window is the Windows task bar.



Activation key: This list will allow you to select the combination of keys that will 
cause Camera to capture a screen. Note that some applications trap some of these
key combinations for their own use. If you can't capture a screen in a particular 
Windows application, you may have to select another key combination.

Time Delay: If this value is set to a value greater than zero, Camera will wait for 
the specified number of seconds before it captures your screen. It will beep once 
per second. This is useful for capturing menus that disappear as soon as you hit a 
key, or dialogs which trap all the key strokes that Camera recognizes. You can tell 
Camera to capture a screen and then get the menu or dialog in place before it 
goes off.

When you activate Camera to capture a screen, it will beep and your cursor will turn 
into an hourglass while the capture file is being written. When the capture is complete, 
the cursor will resume its previous appearance and Camera will beep again.

All the information in the Setup box will be saved when close Camera. They're stored 
in a file called GWSPCAM.INI in your \WINDOWS directory.

Note: Camera cannot capture a full-screen DOS session. It also cannot capture a
DOS window unless you set it to capture the whole screen. This is unfortunate – 
it's just the way Windows works.

Important: Camera makes calls to the main executable file of Graphic Workshop 
Professional. It will not run if it's moved to a directory other than that of 
GWSPRO.EXE, or if it's distributed without the rest of Graphic Workshop. If you 
register Graphic Workshop Professional by entering your registration code and name 
in the Graphic Workshop Setup dialog, Camera will not recognize the code until you 
have exited Graphic Workshop once. Registered users of Graphic Workshop 
Professional will not see Camera's beg notice when it runs.



Selecting Files

Graphic Workshop processes the files that are selected in the topmost browser 
window. It offers a number of ways to select files. It's useful to know about these – 
they'll save you a lot of time if you want to work with directories containing large 
numbers of graphics.

You can select files:

- One at a time, by clicking on their names

- In groups, by clicking on the first file in the group to be selected, holding down the 
Shift key and clicking on the last file in the group to be selected. All the intervening files
will be selected.

- By clicking on the Tag All button in the button bar or by selecting Tag All from the File 
menu, which will select all the files in the current directory.

- By holding down the Shift key and clicking on the Tag All button. Graphic Workshop 
will prompt you to enter a wild-card specification for files to select. For example, if you 
enter T*.GIF, all the GIF files having names which begin with the letter T will be 
selected. If you enable Clear Existing Selections, any presently selected files will be 
unselected before your wild-card selection is processed. Note that you can call this 
function multiple times to tag files corresponding to different wild-card specifications.

Having selected some files, you can subsequently unselect them by:

- Clicking on the individual file names to be unselected.

- Clicking on the first file in the group to be unselected, holding down the Ctrl key and 
clicking on the last file in the group to be unselected. All the intervening files will be 
unselected.

- By clicking on the Clear button in the button bar, which will unselect all the files in the 
current directory.

- By holding down the Shift key and clicking on the Clear All button. Graphic Workshop 
will prompt you to enter a wild-card specification for files to unselect.

Note that the current number of selected files in the topmost browser window will be 
displayed in the Graphic Workshop status bar.



Slide Show

Graphic Workshop will display selected graphics in a continuous slide show. While 
hardly as sophisticated as a presentation package, the slide show function is an easy 
way to view a collection of images while you sit back in your chair and test the tensile 
strength of its springs.

To use the slide show function, select several images in a browser window and click on
the View button, the one with the sunglasses. A small menu will appear. Click on the 
slide option. You can also select Slide Show from the Image menu. The Slide Show 
Options dialog will appear.

You can configure Graphic Workshop's slide show to display each image for whatever 
duration you like. You can configure the background colour and the font Graphic 
Workshop will use to display the name of each file in the slide show – assuming that 
you want the file names displayed at all. You can also enable the Zoom option, which 
will automatically scale files too large to fit on your screen down to size. Note that 
zooming only scales the image being displayed – it will not actually change anything in 
your source graphic files.

If you enable the Loop option, your slide show will run indefinitely until you interrupt it –
rather like the vacation photographs from hell that still flicker and ooze from traditional 
slide projectors around the world. If the Loop option is not enabled, your slide show will
stop when it runs out of images.

Click on OK to start the slide show.

Once a slide show has begun, you can interrupt it by hitting the Esc key or by clicking 
with the right button of your mouse. You can also have it proceed immediately to the 
next slide by hitting Enter.

The slide show function will skip animation files.



System Information

The System Information dialog will provide you with an overview of the configuration of
your computer. This can be useful in unraveling configuration issues. It includes the 
following:

Screen Width and Screen Depth: These are the dimensions in pixels of your current 
screen display mode. 

Network Present: If this field is set to Yes, Windows is of the opinion that your 
computer is connected to a network of some sort.

Slow Machine: This field indicates Windows' assessment of the speed of your 
computer.

Windows Version: This is the internal version number for your installation of 
Windows.

Machine Owner: This is the owner name used when you installed Windows.

Organization: This is the organization or company name used when you installed 
Windows.

Colour Depth: The last item in the System Information dialog indicates the number of 
colours which your current Windows screen driver can display without dithering. If this 
number is 256 or less, Graphic Workshop Professional is running a lot slower and 
looking a lot uglier than it needs to. See the Drivers document for help in reconfiguring 
your Windows screen driver.



Thumbnails

The thumbnail mode of Graphic Workshop is an alternate way of selecting files to work
with. In thumbnail mode you can see small previews of each file in your current 
directory, in addition to the file names. This makes it easier to see what files look like 
before you open them. It also means, however, that you'll be able to see fewer files at 
a time.

Each browser window can display the names of the files it sees in one of four modes. 
These modes are:

· Small text – just the file names
· Normal text – just the file names plus a grey document icon
· Small thumbnails – the file names plus small thumbnail images
· Normal thumbnails – the file names plus normal thumbnail images

By default, Graphic Workshop will open browser windows in the latter mode. You can 
change this once a browser window has been open, and you can configure Graphic 
Workshop to use a different default mode for new browser windows if you like.

You can change the browser mode of a browser window by clicking on the Thumbnail 
button in the Graphic Workshop tool bar. A small menu will appear with four icons – a 
large thumb and a small thumb for normal and small thumbnails and a large "A" and a 
small "A" for normal and small text. Select the mode you want your browser window to 
show you. You can change this mode whenever you like.

Note that you can also create multiple browser windows pointing at the same directory 
but in different modes and just switch between browser windows, rather than changing 
modes, if you like.

The current browser mode is remembered between sessions, along with the window 
size and position, for each open browser window.

If you point a Graphic Workshop browser window at a directory of your own graphics, 
you'll probably see a field of the grey thumbnail symbols. Because thumbnails take a 
few seconds to create and they occupy space on your hard drive, Graphic Workshop 
will not create them unless you tell it do so. Here's how to create a thumbnail.

1. Click once on the graphic you'd like to have a thumbnail for. This will select the 
file.

2. Select Add Thumbnail from the Thumbnail menu.

A thumbnail should appear for the selected graphic after a brief pause.

Adding thumbnails, like all the other image processes Graphic Workshop can do, can 
be done with more than one file at a time. If you select more than one file and add 
thumbnails as was discussed above, all the selected files will have thumbnails created 
for them.



Note: If you hold down the Shift key and click on the Thumb button, the Add 
Thumbnails function will be invoked as if you'd selected Add Thumbnails from the 
Thumbnail menu.

Thumbnails are stored in files on your hard drive. These files have the name of the 
graphic files they're associated with and the extension THN. As such, if you add a 
thumbnail to the file PICTURE.JPG, the thumbnail will reside in a file named 
PICTURE.THN. Thumbnails are always stored in the same directory as the graphic 
files they refer to.

Note that the thumbnail for PICTURE.PCX will also be PICTURE.THN. Files in 
different formats will share the same thumbnail. This helps conserve disk space, but it 
could cause you some confusion in using the comments and key word features of the 
thumbnails, as discussed elsewhere in this document. As there is little reason to keep 
multiple copies of the same image in the same directory, you probably needn't worry 
about this.

You can have Graphic Workshop automatically create new thumbnails for files it writes 
to disk by enabling the Autocreate Thumbnails option in Setup.

You cannot use thumbnails or the Details and Search features for Kodak Photo-CD 
PCD files, MPEG and MOV movies or WAV and MIDI files.

Here's what the Thumbnail menu options do:

Add Thumbnails
If you select one or more files and then select Add Thumbnails from the Thumbnail 
menu, thumbnail images will be created for each of the selected images. These will
replace the default grey thumbnail symbol. Note that if you add thumbnails to 
images which currently have thumbnails, new thumbnails will be created for them 
and any key words and comments previously associated with the images in 
question will be discarded.

Add Thumbnails Where Required
This function behaves like Add Thumbnails, save that it will not create thumbnails 
for images which already have them.

Remove Thumbnails
The Remove Thumbnails function of the Thumbnail menu will remove the 
thumbnail images, comments and key words for all the selected images. The 
thumbnail images will be removed from all the browser windows looking at the 
directory in question, to be replaced by grey thumbnail images. 

Keywords and Comments
The Keywords and Comments function of the Thumbnail menu will allow you to 
add comments and key words to selected images. This information will actually be 
stored in THN thumbnail files associated with the images in question.

You can store anything you like in the Comments field of the Keywords and 
Comments dialog. The key words should contain information to search by. For 
example, in adding key words to pictures of animals, you might use key words 



such as BIRD, AMPHIBIAN, INSECT, ELEPHANT, POLITICIAN and so on. 

Search for Keywords
The Search for Keywords function of the Thumbnail menu will allow you to search 
through all the images with thumbnail entries in your current directory for specific    
key words. Any entries which match the key words you specify will be selected. 
You can subsequently view, print, examine or change the details and otherwise 
perform the usual Graphic Workshop batch functions on them.

If you enter more than one key word into the Thumbnails Search box, you can 
select how the search should treat them using the And and Or options. With And 
selected, only those entries having all the key words you've entered will be 
matched. With Or selected, any entry having at least one of the key words you've 
entered will be matched.

If you disable the Clear Tags before Search option, any currently selected entries 
will be left selected by the search. 

You can search for partial matches of keywords if you enable the Partial Matches 
option in the Search dialog. Thus, for example, you could find all the wombats by 
searching for WOM or BAT. This option can be used in conjunction with the And 
and Or functions.

View
The View submenu will allow you to select which of the four view modes discussed
earlier should be used for the current browser window. It has the same function as 
the menu which appears when you click on the thumb button.

Thumbnail images can be dithered or not, as you prefer. See the Configuration 
document for more information about selecting a thumbnail dithering option. You can 
configure Graphic Workshop to use your choice of images for the symbol which 
appears when no thumbnail is present. This is also discussed in the Configuration 
document.



Thumbnail Database

By default, Graphic Workshop stores thumbnails in files with the extension THN, as 
discussed in the Thumbnails section of this document. This can present Graphic 
Workshop with two specific problems, to wit:

It can't store thumbnails on existing CD-ROMs, and as such graphics on CD-ROMs
can't be browsed with thumbnail images. As least, they can't if the thumbnails are 
to be handled as THN files.

Because THN files apply to all the images with the same name as the THN file in 
question, different graphics in the same directory having the same name but 
different formats will display the same thumbnail even if they in fact contain 
different images. This is a somewhat unlikely occurrence in the normal application 
of Graphic Workshop.

The thumbnail database option of Graphic Workshop addresses these issues. If you 
configure Graphic Workshop to store its thumbnails in the thumbnail database, rather 
than in individual THN files, all your thumbnails will be maintained in a file called 
GWSPRO.TDB in the Graphic Workshop parent directory. Each entry in the database 
includes a thumbnail and the path, volume name and serial number of the drive it's 
located on. As such, when Graphic Workshop wants to display a thumbnail, it can be 
instructed to look in the database, rather than looking for THN files which correspond 
to your pictures.

This gets around the issue of Graphic Workshop not being able to write THN files to 
CD-ROMs, as all its thumbnails will be written to the GWSPRO.TDB database file 
stored on your hard drive.

There are several considerations to keep in mind if you enable the thumbnail 
database.

Accessing thumbnails from the thumbnail database will get progressively slower as the
database gets larger. On a fast system this probably won't become noticeable until you
have several thousand of thumbnails in the database.

When Graphic Workshop updates or deletes a thumbnail from the thumbnail database,
it does not actually remove it. Because manipulating the database to remove records 
is very time consuming, it just marks the deleted records and thereafter ignores them. 
To keep your thumbnail database from growing to truly enormous dimensions, it's 
necessary to compact it from time to time, to remove the deleted records. This will be 
discussed in detail in a moment. Compacting the database isn't difficult – it's just 
something you'll need to do from time to time if you enable the thumbnail database 
options.

If you delete a graphic file which is referenced by the thumbnail database through an 
application other than Graphic Workshop, Graphic Workshop won't know that it's been 
deleted and its thumbnail will remain as an orphan in the database until you compact 
it.



As noted earlier, the thumbnail database can display different thumbnails for images 
having the same file name but different extensions.

Note: Because the thumbnail database stores information about the location of each 
file it references, manually moving your graphics around or changing the volume name
or serial number of the drives where they're stored will usually invalidate their entries in
the database. If this happens, they will no longer display with thumbnails until you add 
new thumbnails for them. 

You can configure and maintain Graphic Workshop's thumbnail database through the 
Thumbnail Database item of the Thumbnail menu. Here's what its options do:

Reading Thumbnails

Only Check Disk: Graphic Workshop ignores the thumbnail database when it 
looks for thumbnails and only retrieves them from THN files.

Check Disk, then Database: Graphic Workshop looks for thumbnails as THN 
files and only checks the database if it doesn't file a suitable THN file. Enable 
this option if you assign thumbnails to images on your CD-ROMs. Note that 
doing so does impose a small but measurable speed penalty on Graphic 
Workshop's browser windows when they're in a thumbnail mode and they 
encounter directories on your hard drive with images having no THN files.

Only Check Database: Graphic Workshop ignores any THN files which might 
be present when it wants to display thumbnails, and only looks in the thumbnail
database. This option isn't recommended unless you have a very good reason 
to use it.

Writing Thumbnails

Write to Disk: Graphic Workshop ignores the thumbnail database when it 
creates thumbnails and only writes them to THN files. If it can't write a THN file,
as in the case of graphics on a CD-ROM, no thumbnail is created.

Write to Database: Graphic Workshop never creates THN files, but stores all 
its thumbnails in the thumbnail database. This option will typically leave you 
with a really enormous GWSPRO.TDB file, and isn't recommended unless you 
have a very good reason to use it.

Write to Database if Disk Fails: Graphic Workshop attempts to create THN 
file when it wants to store thumbnails and only writes them to the database if it 
can't write a THN file. Enable this option if you wish to display thumbnails for 
graphics stored on CD-ROMs.

Preserve Unique File Extensions: If this option is enabled, Graphic Workshop 
will display unique thumbnails for each file in a directory even if files exist having 
the same names with different extensions.

Compact Now: Click on this button to compact the thumbnail database. 
Compacting the database will remove any deleted records and any records which 



reference files that can't be found on your system. 

Include Removable Drives: If this option is enabled, the compacting process will 
check for the existence of graphic files referenced by the database even if they 
exist on CD-ROMs, floppies or network drives. If it finds that they don't exist, it will 
remove their entries from the database. You should disable this option to compact 
the database if you have added thumbnails to the database for graphics on CD-
ROMs, floppies or network drives which are not on line when you click on Compact
Now.

The database compacting function copies the records of your thumbnail database to a 
new file, ignoring those records which are to be removed. There must be enough free 
hard drive space on the drive where your Graphic Workshop parent directory is located
to create a temporary file as large as the original GWSPRO.TDB file or the compact 
function will fail.

Note: If you have CD-ROMs of graphics created by Alchemy Mindworks – our graphic 
collections or the graphics included with the Alchemy Mindworks software installation 
CD-ROM – you will not need to enable the thumbnail database to see thumbnails for 
these images. Our CD-ROMs are created with THN files for each of the available 
images.



Transform

The transform function will rotate an image in ninety degree increments or mirror it 
horizontally or vertically. These functions work on images with any number of colours. 

By default, if you have Graphic Workshop transform a file it will create a new file for 
you of the type you select and with "T_" prepended to its name. Thus PICTURE.GIF 
could be written to T_PICTURE.GIF, for example. This option can be disabled in 
Setup.

The 90° and 270° rotate functions cannot be used with virtual memory.

Note that the Transform function can only rotate files in 90-degree increments. If you'd 
like to rotate an image by a smaller amount, use the Transform function in View mode, 
as is discussed elsewhere in this document.



View and Filters

If you double click on a file name or select one and then click on the View button, 
Graphic Workshop will open a View window and display the selected file. Select 
multiple files and click on the View button to show several files one after another. 

Note that the View button is located in a small menu that appears when you click on 
View in the tool bar.

If the picture you have selected is larger than your screen, you can use the cursor 
movement keys and the View window scroll bars to pan around it. Hold down the Shift 
key when you hit a cursor key to move in larger increments.

To exit a display window, you can do any of the following:

· Hit Enter or Esc on your keyboard. If you have selected multiple files to view at 
once, Enter will display the next file and Esc will abort any further files and 
return you to the main screen. 

· Open the Picture menu in the View window and select either Next or Cancel. If 
you have selected multiple files to view at once, Next will display the next file 
and Cancel will abort any further files and return you to the main screen. 

· Right-click with your mouse and select Next or Cancel from the menu that 
appears.

Graphic Workshop can be configured to close its view windows as soon as you right-
click in one, and not display the right-click menu.

By default, Graphic Workshop's display windows will size themselves to fill your 
screen. You can configure Graphic Workshop to create display windows which are 
sized to the dimensions of each graphic you view if you like.

You can delete files from within View mode either by selecting Delete from the Picture 
menu or by hitting the Del key on your keyboard. If you hold down the Ctrl key and hit 
Del, you will not be prompted to confirm that you wish to delete the file in question. 
Once a file has been deleted, View mode will automatically terminate and display the 
next selected file if there is one. If you want to sort out a lot of files, select them all, 
click on the View button and use this feature to kill the ones you don't want to keep. 
Note that files deleted through View mode are handled the same way as files deleted 
directly from a browser window. See the section of this document which deals with 
deleting files for more about this.

If your graphic requires more colours than your current Windows screen driver can 
display, Graphic Workshop will display a dithered version of it. Graphic Workshop will 
use an eight-colour dither if you have a sixteen-colour display and a 256-colour dither 
if you have a 256-colour display. These dithers have been optimized for speed rather 
than for image quality, although the 256-colour dither can look pretty respectable as 
dithers go.



This assumes that Graphic Workshop has not become horrified by your sixteen-colour 
Windows screen drivers and run screaming from the room, requiring eleven to fifteen 
weeks of intense therapy and post-traumatic counseling, as discussed elsewhere in 
this document.

Many graphic files include file comments, which may tell you about more about the 
pictures stored in your files or explain their copyright. You can configure Graphic 
Workshop to display file comments through the Setup dialog.

You can perform a variety of image processes on graphics in the View mode by 
selecting the Filters item from the Picture menu. The Image Filter dialog will appear – 
select the filter type you wish to use and adjust its parameters accordingly. Click on 
Preview to see what the effect of your parameter selection looks like, and on OK when 
you're happy with the results. The scroll bars around the example image will let you 
see different areas of your adjusted graphic. The button to the lower right of the 
example image will return to the center of your graphic.

Graphic Workshop regards images to be filtered as being of four types:

· Monochrome images, which have two colours.
· Palette images, which have between four and 256 colours.
· Grey scale images, which have 256 levels of grey
· True colour images, which have sixteen-million colours.

Some filters are only available for specific image types and will not appear if you 
attempt to filter an image for which they are not applicable.

Note: 256-colour photorealistic images got that way by being dithered from true-colour
images. If you promote them to true colour, a lot more of the filters will be available to 
work with them. However, doing so does not undither them and you'll probably find 
some pretty strange things happening when you try to filter them. Be warned. The 
same is true if you convert a dithered 256-colour image to grey scale.

Here are all the available filters:

Average: softens images.
Blurr: blurrs images.
Colour and Intensity: allows you to interactively adjust the colour and intensity of 
an image.
Contrast and Brightness: allows you to adjust the contrast and brightness of an 
image.
Convert to Grey: converts images to grey scale.
Convert to Mono: dithers and thresholds images to two colours.
Convert to RGB: promotes images to true colour.
Edge Trace and Fatten: traces the edges of monochrome images or fattens their 
details.
Emboss: creates embossing effects.
Enhance Edges: locates the edges of objects in image sand makes them more 
noticeable.
Equalize: interactively redistributes the shadows and highlights of images.
Obscure: makes images look like they're about to enter the witness protection 



program.
Reverse: makes negatives.
Scale: resizes images. See the Scale section of this document for more about 
scaling.
Sharpen: sharpens images.
Transform: flips and rotates images. Use the Free Rotate option to rotate an 
image in increments of less than 90 degrees.
Water Drops: makes image look like they're being viewed through water drops.
Waves: adds waves to images. This one can look truly weird.

The Free Rotate feature of the Transform filter allows for rotation by any angle from 
zero through 360 degrees in one-degree increments. It will rotate either clockwise or 
counter-clockwise. 

Note that because free-rotating will result triangular margins around your rotated 
image, you can select the destination image background colour in this mode. The 
background colour is used to fill the margins. Click on the Background colour button to 
select a background colour. The available background colours are drawn from the 
image palette for images with 256 or fewer colours. True colour background colours 
can be selected from an evenly dispersed 256-colour palette.

Free rotation looks pretty reasonable when it's applied to grey scale and true colour 
images – applying it to dithered images can introduce some aberrations into your 
rotated graphic.

Free-rotating an image will usually leave it with at least slightly jagged edges.

By default, the size of a rotated image will be increased to allow the whole image to be
included. The Preserve Size feature of the Free Rotation function will crop the 
destination image to fit within the dimensions of the source image.

Rotation always takes place around the centre of the source image, and is rotated to 
the centre of the destination image.

You can save a filtered picture to a new file by selecting Save As from the Picture 
menu. 

The Filters option is not available for images which have been unpacked into virtual 
memory.

The Undo item in the Picture menu will be active once you have used the Filter 
function. It will undo the most recent filter operation.

Note that if you want to apply more than one filter to the image, you must invoke the 
Filter function multiple times.

Softening and then sharpening a scanned graphic with the Filter function is an effective
technique for reducing scanning moirés.

You can get information about an image while you're in View mode by selecting Get 
Info from the Picture menu.



If you're viewing a small image, select Tile from the Picture menu to have it duplicated 
over the entire view window. This is handy for seeing what tiled BMP files will look like 
if you use them as wallpaper, and for viewing web page background textures.

The View menu in a View window will allow you to select the degree of magnification at
which your image will be displayed. Zooming in on an image – increasing the 
magnification – will effectively increase the size of its pixels, and the displayed image 
will get chunkier the more you zoom in. The Zoom to Fill item in the View menu will 
select the appropriate magnification level to best fill your display window.

By default, Graphic Workshop opens graphics in View mode at a magification level of 
100 percent. You can change this in Setup such that it defaults to any View 
magification level you like, or to Zoom to Fill.



Using Association Wizard

Read this section carefully before running Association Wizard. If you 
have Association Wizard associate file types with Graphic Workshop 
and you subsequently remove Graphic Workshop from your hard 
drive, you must re-associate the selected file types through Windows 
Explorer to other applications, as discussed in the Reference 
document for Graphic Workshop.

The Association Wizard application will allow you to quickly associate one or more 
image file types with Graphic Workshop Professional. Having done so, you will be able
to double-click on files of the associated types in Windows Explorer and Graphic 
Workshop will boot up and display the files in question. Note that in this mode Graphic 
Workshop will not display its conventional user interface – when you exit a viewed 
graphic in Graphic Workshop launched from Explorer, Graphic Workshop will terminate
immediately.

Associated file types are also used by many other Windows applications. The 
Documents item of the Start menu uses file associations to decide which application to
run when you select a recently opened document.

Note: Unlike Graphic Workshop itself, Association Wizard will make permanent 
changes to your Windows registry – it must do so to establish associations. 
These changes, once made, cannot be undone automatically. Previous 
associations which it overwrites are not preserved. If you wish to un-associate 
specific file types after you have run Association Wizard, you must do so 
through Windows Explorer. This is discussed in detail the Graphic Workshop 
Reference document.

If you run Association Wizard, you will see a list of most of the file types Graphic 
Workshop recognizes. Some of these will have check marks to the left of them. If you 
click on the Associate button, the file types with check marks will be associated with 
Graphic Workshop Professional.

Association Wizard defaults to selecting file types it thinks should be associated with 
Graphic Workshop. You're free to disagree with it – you can toggle the selection of any 
file type by clicking on its item in the Association Wizard window. Items which do not 
have check marks will not be associated with Graphic Workshop.

Some forethought and care is called for in using Association Wizard. Not all the file 
types Graphic Workshop knows how to work with should be associated with it. For 
example, you would probably not want to associate BMP files with Graphic Workshop 
if you like to be able to double-click on them and have them open in Windows Paint. 

The file types associated with Graphic Workshop do not affect the operation of Graphic
Workshop itself – it will be able to view all the file types it supports through its user 
interface irregardless of what file types are associated with it.



Animation and Multiple-Image Formats

Some graphic file formats, such as FLI and AVI, are actually animation sequences – 
that is, each file contains multiple frames or images. Some conventional still graphic 
file formats can contain multiple images as well. 

If you attempt to process a file with multiple images in it, the Select Image dialog will 
appear to prompt you for the image to unpack from your file. The selected image will 
subsequently behave as if it had come from a conventional single-image format.

The Select Image dialog will allow you to view the entire animation for those formats 
which contain animated sequences. Click on View to do so.

The Preview switch can be used to disable the display of example images in this 
dialog.



Registering Graphic Workshop Professional

Graphic Workshop Professional and all its ancillary applications are 
shareware. We invite you to evaluate the Graphic Workshop 
Professional package to see if it's suitable for your needs. If you like it,
please register it. If it turns out not to be what you need, or if you 
don't feel it's worth registering, please delete it from your hard drive 
and accept our thanks for trying it out. If you do productive work of 
any sort with this software, you are no longer evaluating it.

If you like Graphic Workshop Professional and you find it useful, you are requested to 
register it. The current registration fee is $40.00 – plus $5.00 shipping if you'd like the 
latest version sent to you on CD-ROM. This will entitle you to technical support, 
notification of updates, a free copy of the latest version of this software and other 
worthwhile things. It will also avail you of a registration number to shut off the closing 
beg notice. More to the point, though, it'll make you feel good. We've not infested 
Graphic Workshop with excessive beg notices, crippled it or had it verbally insult you 
after ten days. We trust you to support this software if you like it.

When you register Graphic Workshop, you will be e-mailed your registration code as 
soon as your order is processed. Enter your code into a downloaded copy of Graphic 
Workshop and it will become a registered copy, identical to what you would receive on 
CD-ROM. If you want to save the $5.00 shipping fee, select the NO SHIPPING option 
when you order. Note that absolutely nothing is shipped for NO SHIPPING orders – not
even a receipt.

If you want to see additional features in Graphic Workshop, register it. If we had an 
Arcturian mega-dollar for everyone who has said they'd most certainly register their 
copy if we'd add just one more thing to it, we could buy ourselves a universe and retire.

Oh yes – should you fail to support this program and continue to use it, a leather
winged demon of the night will tear itself, shrieking blood and fury, from the 
endless caverns of the nether world, hurl itself into the darkness with a thirst for
blood on its slavering fangs and search the very threads of time for the 
throbbing of your heartbeat. Just thought you'd want to know that.

Order On Line

You can order on line at our web page http://www.mindworkshop.com/alchemy/alchemy.html     – 
click on any of the blue key icons to access the secure server.

Order by Phone



Call our toll-free order desk at 1-800-263-1138 from Canada and the United States. 
Call 0800-89-7355 from Great Britain. Call 1-800-554-082 from Australia. Callers from 
other countries can reach the order desk at 1-905-936-9500. The order desk is 
available 24 hours a day, seven days a week.

Please note: the order desk only takes credit card orders. They cannot provide 
you with order status, modify or cancel previously submitted orders, provide 
product information or help you out with technical support. They cannot transfer
you to someone who can.

Order by FAX

You can FAX your order to 1-905-936-9502. Please use the order form included with 
this software. 

Order by Snail-Mail

You can mail your order to:

Alchemy Mindworks Inc.
P.O. Box 500
Beeton, Ontario
L0G 1A0
CANADA

Please use the order form included with this software.

If you're paying by a cheque drawn on a bank outside North America, please be sure 
to make your cheque payable in US dollars. Your cheque must have the address of a 
North American clearing office and a bank transit number printed on it. Please do not 
send us Eurocheques – they cannot be cleared outside Europe.

Note that when you send us your order – and then when we send you your software – 
two distinct post offices get to deal with the ensuing mail. It can take a few weeks for 
things to get through this system – we ask that you be patient. We don't fully 
understand why it takes less time for a package to get to Australia than it does to send 
one to Cleveland. Some things are best left as mysteries.

Paying by Plastic

We can accept credit card payments by:



Registration Fee

Canadian users: The registration fee for Graphic Workshop Professional is $40.00 
(CDN) plus seven percent GST, plus $5.00 shipping, or $47.80. We sincerely regret 
collecting this tax on behalf of several levels of government which will only squander it.
If you sincerely regret having to pay it, we urge you to express your regret by voting in 
the next federal and provincial elections. 

American users: The registration fee for Graphic Workshop Professional is $40.00 
(US) plus $5.00 shipping. 

Other users: The registration fee for Graphic Workshop Professional is $40.00 (US) 
plus $5.00 shipping.

Payment from countries outside Canada must be in US dollars. Please note that we 
are not able to accept purchase orders. We cannot ship software COD.

All orders are processed immediately. Please see the Terms, Conditions and Legal 
Dogma document included with this software for complete ordering details and all the 
stuff the lawyers made us say.

Update Policy

Having registered Graphic Workshop Professional, you're welcome to download the 
current shareware version whenever you like and install it. It will locate your existing 
registration code and become a registered copy. If you find new features in a 
downloaded copy which are genuinely useful to your application of Graphic Workshop, 
we'd like to ask you for $20.00. If none of the new features are specifically applicable 
to what you're doing, or if you just downloaded a newer version to fix bugs, please 
treat it as a free maintenance release.

We invite you to add your e-mail address to the e-mail update list at our web page, 
http://www.mindworkshop.com/alchemy/alchemy.html – you'll be notified by e-mail 
wherever we update Graphic Workshop.

Upgrading from Graphic Workshop Classic

If you have registered a copy of Graphic Workshop Classic – that is, Graphic 
Workshop for Windows 1.0, 1.1 or 1.2 – , you can update to Graphic Workshop 
Professional for $20.00 (US) – plus $5.00 shipping if you'd like a copy of Graphic 
Workshop Professional sent to you on CD-ROM. Please be sure to quote your existing
registration code when you upgrade to ensure that you're charged the upgrade price, 
rather than the full price.

Note that Graphic Workshop Classic registration codes will not work in Graphic 
Workshop Professional.



Contacting Alchemy Mindworks Inc.

Graphic Workshop Professional and all its ancillary applications are 
shareware. We invite you to evaluate the Graphic Workshop 
Professional package to see if it's suitable for your needs. If you like it,
please register it. If it turns out not to be what you need, or if you 
don't feel it's worth registering, please delete it from your hard drive 
and accept our thanks for trying it out. If you do productive work of 
any sort with this software, you are no longer evaluating it.

The best way to get in touch with us is by e-mail to alchemy@mindworkshop.com. Except
in conditions of flood, famine or mental-health days, our e-mail is answered within a 
few hours.

Technical support and customer service are available at 1-905-936-9501, 10:00am to 
5:00pm EST most business days. If you encounter our answering machine – it does 
happen occasionally – please try back later. One of the considerations in offering 
very low cost software is that we are unable to return calls for technical support.

If you are an unregistered user of this software, we will at our discretion assist you to 
the extent required for you to ascertain whether this software is suitable for your 
application. 

Callers who are rude, abusive or pig-headed with our technical support staff will wind 
up as demon-chow. See the section on Registration elsewhere in this document.

Please do not call our 800 number for technical support. The people who answer 
our sales line can put a credit card machine into warp drive, but they know less about 
software than most cats know about quantum mechanics. They are unable to transfer 
your call.

You can contact us by snail-mail at:

Alchemy Mindworks Inc.
P.O. Box 500
Beeton, Ontario
L0G 1A0
Canada

Our FAX number is 1-905-936-9502. 

We are unable to provide technical support by FAX or snail-mail.

The Alchemy Mindworks BBS – poor, barnacle-encrusted antique that it is – is 
available twenty-four hours a day at 1-905-936-9503. As of this writing, the protocol 
was 300, 1200 or 2400 baud, or 9600 baud v.32bis, eight data bits, no parity and one 
stop bit. The bulletin board always has the most recent versions of all our shareware 



on it, plus bug fixes, drivers and other relevant information. It only exists to support 
Alchemy Mindworks' shareware... it does not have a general file area.

We ask that in contacting us you appreciate that we are a small company with limited 
resources. If you have not registered this software we will not tell you to go to hell, but 
please don't ask us for half an hour of free technical support. We have not built the 
price of technical support into the cost of Graphic Workshop, as few users require it. 
We believe very strongly in not making everyone pay for something that only a small 
group needs. If our various governments felt the same way, our various economies 
wouldn't be in the midst of melting down.



Resource Extractor

Resource Extractor is an ancillary application included with Graphic Workshop. You 
can access it through its desktop icon, or by selecting Resource Extractor from the 
Graphic Workshop Professional section of the Programs menu. It cannot be accessed 
through Graphic Workshop itself.

Windows applications and the libraries they use are constructed of executable 
programs – the things your computer actually runs to make something happen – and 
chunks of data. These chunks of data are called “resources.” Windows resources are 
structured to allow them to be accessed as discrete entities by the programs that use 
them. Resources can include things like graphics, icons, text, sounds and so on. 
Windows resources also include a lot of fairly technical objects, such as dialog 
templates and accelerator tables, which will be if little interest if you don’t actually write
Windows software. These latter entities will not turn up in this discussion.

The nature of Windows resources is that they can be accessed by applications other 
than the ones that own them. Using suitable software, it’s possible to open a Windows 
executable file or library, browse the resources therein and copy the ones you like to 
new files.

One of the most commonly accessed Windows libraries in this regard is the file 
MOREICON.DLL, which can be found in your \WINDOWS directory. This is a library of 
Windows desktop icons. You can use this library to replace the icons of common 
Windows applications if you want to customize your Windows desktop.

Resource Extractor is a tool for snooping around in Windows executable files and 
libraries to search for icons, graphics, sound and text resources. It will allow you to 
browse through files having the extensions EXE, DLL and VBX. If you find resources 
you like, you can save them to disk.

Resource Extractor will save graphics to BMP files, icons to ICO files, string tables to 
TXT files and binary data to BIN files. If it encounters binary data which is in fact a 
Windows sampled sound, it will save the resource to a WAV file. In a Windows 
application, binary data is any collection of stuff that Windows can’t think of a better 
name for. With the possible exception of Windows WAV files stored as resources, most
binary data only makes sense to the applications that own it, and can safely be 
ignored.

To use Resource Extractor, run the Resource Extractor application and select Open 
from the File menu. Locate a suitable EXE, DLL or VBX file. The file will open in 
Resource Extractor and present you with a list of resource types in the left part of the 
Resource Extractor main window.

There are several potential problems Resource Extractor can encounter upon opening 
a file:

- The file is not a standard Windows executable or library: This means that you
have attempted to open a file which Resource Extractor doesn’t recognize as 
being a Windows application. It could be a DOS application or an OS/2 application,



for example, or it could be corrupted.

- The file appears to be corrupt or there was a problem allocating memory: 
This usually means the file is damaged. A damaged file can confuse Resource 
Extractor into thinking it requires enormous amounts of memory to unpack it.

- There are no interesting resources in the file you attempted to open: The 
oddest things interest software. This message means that there are either no 
resources at all in the file you attempted to open – not an unheard-of situation – or 
that none of them are graphics, icons, text or binary data.

When Resource Extractor has successfully opened a file, it will display a tree which 
lists each of the resources it finds. Click once on any resource to view it. Select Save 
As from the File menu or the right-click menu to save the selected resource to a file. If 
the selected resource is a sound stored as binary data, the Play item in the File menu 
and in the right click menu will be active – select Play to heard the sound.

Keep in mind that Resource Extractor only reads the applications and libraries it opens
– it cannot change them. As such, you can extract resources ‘til your mouse melts 
without any risk of damaging any of your applications or system files.

You can turn Resource Extractor loose on any EXE, DLL or VBX files on your hard 
drive. The \WINDOWS, \WINDOWS\SYSTEM and \Program Files directories are a 
good place to start looking for things to try it out on.

Legal dogma: In browsing through applications and libraries on your hard drive, you’ll 
probably find some interesting graphics and quite a few icons to make your desktop 
more colourful. As long as the things you find stay on your hard drive, no one is likely 
to complain about this. Note, however, that the icons, graphics and other resources 
Resource Extractor can locate are typically copyrighted entities belonging to the 
developers of the software in question. Distributing these objects to someone else or 
modifying them for commercial use would be a clear violation of said copyright – as 
well as being unethical, doing so offers a fairly good possibility that someone’s lawyer 
will show up at your digs and start chewing on your leg.

Important: Resource Extractor makes calls to the main executable file of Graphic 
Workshop Professional. It will not run if it's moved to a directory other than that of 
GWSPRO.EXE, or if it's distributed without the rest of Graphic Workshop. If you 
register Graphic Workshop Professional by entering your registration code and name 
in the Graphic Workshop Setup dialog, Resource Extractor will not recognize the code 
until you have exited Graphic Workshop once.



Rotator

The Rotator application can be used to have Windows change your wallpaper and 
your screen saver periodically. It can be configured to change one or both every time 
windows boots up, or once a day.

When Graphic Workshop is installed, two Rotator icons will be created. The second 
one is titled Rotator (drag to StartUp) – this icon must be moved to the StartUp 
group of your Windows desktop before Rotator will operate. To do this:

1. Locate the Rotator (drag to StartUp) icon in the Graphic Workshop 
Professional shortcut group.

2. Use the right button of your mouse to click on the Start button of your Windows
taskbar.

3. Select Open from the short menu that appears.

4. Double click on the Programs group in the Start Menu window.

5. Locate the StartUp group in the Programs window and double click on it.

6. Drag the Rotator (drag to StartUp) shortcut icon to the StartUp window.

You can now close the StartUp, Programs and Start Menu windows.

The remaining Rotator shortcut icon can be used to configure Rotator. Double click on 
it to access the Rotator application window. The Rotator application will show you two 
lists – the leftmost list contains all your current Windows wallpaper. The rightmost list 
contains all your current Windows screen savers.

There are three options at the top of each of the lists in the Rotator application window.
These tell Rotator how often to rotate the items in question. They are:

Never: Rotator will never rotate the selected items, and will make no changes to 
your current Windows configuration.

Daily: Rotator will rotate the selected items once a day, the first time Windows is 
started up. If you have to start Windows a second time on the same day, Rotator 
will not change anything.

Always: Rotate will rotate the selected items every time you start Windows.

Note that if Never is selected, the list of items it pertains to will be disabled. You must 
select Daily or Always to access the items in one of Rotator's lists.

Click on a list item to toggle its status. Items marked with an X will be included in the 
rotation. You can have as many selected items as you like.

You can preview a list item by right-clicking on it. The right-click dialogs will also let you



configure the items in question. If you right-click on a wallpaper item, you'll see a 
preview of the wallpaper graphic and you'll be able to specify whether the wallpaper 
should be displayed on your desktop centered or tiled. If you right-click on a screen 
saver item, you'll see a preview of the screen saver and you'll be able to configure the 
wait time before the screen saver activates. While Rotator will allow you to rotate 
sixteen-bit Windows 3.1 screen savers, it will not display anything in its preview 
window if you right-click on one.

Note that Rotator only saves the configuration values for selected items in its lists. As 
such, for example, if you set a wallpaper item to display as tiled but it's not selected – 
that is, if there's no X in the check box in its list item – it will not have the Tiled option 
selected in its right-click dialog the next time you run Rotator.

You can force Rotator to step through its rotations with the Rotate Wallpaper and 
Rotate Screensaver items in its File menu. The lists corresponding to these menu 
items must have their rotation options set to Daily or Always to activate these items.

While it's not necessary to understand what Rotator is up to use it, here's how it works,
should you be curious.

The Rotator (drag to StartUp) shortcut icon differs from the Rotator shortcut icon in 
the Graphic Workshop Professional shortcut group in that it has /R appended to its 
command line. When the Rotator application runs and finds this command line 
argument, it knows to rotate through its lists and then terminate immediately.

Any application with a shortcut icon in the StartUp shortcut group will be automatically 
run every time Windows starts up. This gives Rotator the opportunity to change your 
wallpaper and screen saver. 

The Rotator shortcut icon in the Graphic Workshop Professional shortcut group does 
not have a /R in its command line, and as such it allows Rotator to start normally and 
display its application screen.

Rotator's configuration items, including the names of the wallpaper files and screen 
savers in its rotator, are stored in a file called GWPROTR.INI in your \WINDOWS 
directory.

Important: Rotator makes calls to the main executable file of Graphic Workshop 
Professional. It will not run if it's moved to a directory other than that of 
GWSPRO.EXE, or if it's distributed without the rest of Graphic Workshop. If you 
register Graphic Workshop Professional by entering your registration code and name 
in the Graphic Workshop Setup dialog, Rotator will not recognize the code until you 
have exited Graphic Workshop once.



GIF Construction Set

GIF Construction Set UltraLight is a reduced version of Alchemy Mindworks' 
popular GIF Construction Set software. It's a powerful tool for creating web page
animations, as well as transparent and interlaced GIF files.

Note that the full version of GIF Construction Set can do a lot that the UltraLight edition
cannot. We invite you to visit our web page at 
http://www.mindworkshop.com/alchemy/gifcon.html to download the full version. See 
http://www.mindworkshop.com/alchemy/gcsdemo.html for an extensive interactive 
demonstration of what the GIF Construction Set can do. 

The GIF Construction Set UltraLight application is part of the Graphic Workshop 
Professional bundle. Registering Graphic Workshop Professional also registers GIF 
Construction Set UltraLight. Please note that this registration does not extend to the 
full version of GIF Construction Set.



Editing the Header Block

You can modify the following fields of the header block of a GIF file:

Screen width and Screen depth: These are the dimensions in pixels of the 
screen the GIF file would like to be displayed on. They can be any value greater 
than zero. Note that the screen dimensions do not affect the dimensions of images 
displayed from a GIF file, but they may affect where on your screen the images are
placed in a fully compliant GIF viewer. For GIF files destined for web pages, these 
fields should define a rectangle which just encloses all the other elements in your 
file. GIF Construction Set will set these fields correctly each time you save a file.

Background: The background is the colour of the area around the images to be 
displayed if the images in question don't fill your screen. The background is 
actually a number drawn from the current global colour palette. To change the 
background colour, click on the colour button in the Edit Header dialog and select a
new colour. The number in the Background colour button is the actual palette index
being used. Note that the background colour value is ignored by web browsers.

Global Palette: The global palette flag tells GIF viewers whether a GIF file 
includes a global palette. If you change this flag, GIF Construction Set for Windows
will look at the GIF file you're working on to see if there are images which expect a 
global palette and prompt you accordingly. In most applications of GIF files, it's 
desirable to have a global palette.

Sorted: The Sorted flag of Edit Header box allows you to set the state of the sorted
palette flag in the header of GIF files. This flag has no affect on how GIF 
Construction displays images – it may be of importance to other applications which 
read your GIF files.

When you create a new GIF file, a header block will be created automatically. The 
colour depth is set to 256 colours, and a default palette is applied to the header. 



Editing Image Blocks

The Edit Image dialog includes the following fields:

Left and Top: These fields determine where the image in question will be 
displayed on your screen relative to the upper left corner. The values are in pixels. 

Interlaced: This flag determines whether the image in question will be stored 
interlaced or normally.

Local Palette: You can enable a local palette for any image block in a GIF file. By 
default, the palette for the image in question will be used.



Editing Comment Blocks

A comment block consists entirely of text. The Edit Comment Block dialog is a text 
editing window in which you can add, modify and delete the text of a comment block. 
Under GIF Construction Set, a comment block can include up to 32,767 characters.



Editing Plain Text Blocks

Plain text blocks consist of text and some information about how to display it. The text 
can be edited the same way comment block text is handled. The following fields define
how plain text blocks will be displayed:

Text left and Text top: These fields define where the text will appear on your 
screen, relative to the upper left corner of the viewing area. These values are 
defined in pixels.

Foreground and Background: These are the colours used to display the text in 
question. Note that if a plain text block is preceded by a control block which defines
a transparent colour, one of these colours can become transparent. You can select 
these colours either by clicking on their colour buttons or by using the eyedropper 
tool to pick colours from the previous image block if one is present. The 
eyedropper tool will not be active if there is not at least one image block before the 
current plain text block.



Editing Control Blocks

A control block includes the following fields:

Transparent Colour: If this switch is turned on, one of the global palette colours in
subsequent image or plain text blocks will be regarded as being transparent by GIF
Construction Set for Windows when you view a complete GIF file. This means that 
rather than displaying areas of this colour, it will allow whatever is underneath the 
displayed image or text to show through. You can select this colour either by 
clicking on the colour button to the right of the switch or by using the eyedropper 
tool to pick a colour from the next image block if one is present. The eyedropper 
tool will not be active if there is not at least one image block after the current plain 
text block.

Delay: This is the number of 100ths of a second a GIF viewer will pause after 
displaying the next image or plain text block.

Remove by: This tells a GIF viewer what do with an image after it has been 
displayed. Be careful of the Previous Image option – some web browsers don't 
support it.



Editing Loop Blocks

A loop block includes one field, to define the number of times the images in the GIF file
in question will repeat. Note that a Loop block will always appear as the second block 
in a GIF file, no matter where you insert it. Only one Loop block can appear in a GIF 
file.



Inserting Blocks

You can add blocks to a GIF file by selecting Insert from the File menu of GIF 
Construction Set. A dialog will appear to allow you to select the type of block you wish 
to insert. Inserted blocks are always inserted immediately after the currently selected 
block. 

If you attempt to insert an image block into an existing GIF file, a dialog will appear 
prompting you for the file to insert from. Source images for GIF Construction Set 
UltraLight must be in the GIF format.

You can insert multiple images into a GIF file at once – each one will appear as a 
separate Image block. Select multiple images in the Open dialog by holding down the 
Ctrl key and clicking on each image you want to insert. Hold down the Shift key and 
click to select a range of images.

Note that if you import an image from a GIF file using the Insert function, the first 
image in the file will be read, even if the file actually contains multiple images.

If you attempt to insert an image which has a different palette from the current global 
palette of your GIF file, a dialog will appear asking how you'd like to handle the new 
image's palette. These are the available options:

Remap this Image to the Global Palette: This is a good choice for mechanical 
images... drawings and such... and a really bad choice for photographs. Each 
colour in the source image will be replaced by the closest match from the global 
palette. This will usually make photographs look posterized.

Dither this Image to the Global Palette: This is a good choice for photographs. It 
will give you the best colour match... and usually the most attractive results... with a
slight loss in detail resolution.

If you insert other types of blocks... specifically control, comment or plain text blocks... 
default blocks will be created which you can subsequently edit, as has been 
discussed.

The Use This Selection for Subsequent Images option will save time if you're importing
multiple images into a GIF file in one pass. It will apply the current selection in the 
dialog to the remainder of the images to be imported. Note that this item will not be 
enabled if you have selected Use This Image as the Global Palette, as a GIF file can 
only have one global palette.



Using Animation Wizard

The Animation Wizard feature of    GIF Construction Set will walk you through creating 
an animated GIF file. It offers fewer options than you'd have if you were to create an 
animated GIF file from scratch, but it's dead easy to use. It will prompt you for 
information about the animation you want to create, assemble all the necessary blocks
and finally open the file in GIF Construction Set's main window. You can edit it further, 
or just save it to disk.

To create a GIF file with Animation Wizard, simply select this feature from the File 
menu of GIF Construction Set and follow the prompts. You can fine tune your GIF file 
after it has been created by Animation Wizard. The most important questions are: 

Do you want to create an animated GIF file for use in World Wide Web Page?

If you answer Yes to this question, Animation Wizard will choose a palette for 
your GIF file which is optimally compatible with Netscape Navigator. 

Are the images for your GIF file photorealistic or drawn?

Photorealistic images are scanned graphics and computer generated art which 
has gradients. Anything that looks as if it might have started life as a 
photograph should be regarded as photorealistic. Drawn images are graphics 
with hard lines, such as text and line art. Draw images with sixteen colours are 
text and line art which are constrained to use the default Windows palette, that 
is, graphics with very few colours.

The Match to Superpalette option of Animation Wizard will create a new 
optimized palette for your animation based on the palettes of all the source 
images you have selected. This will usually produce the best looking 
animations.

The Match to First Palette option of Animation Wizard will match all the colours 
in all the images you select to the palette of the first image. This will eliminate 
dithering problems when you assemble an animation from source GIF files as 
long as you choose the first image appropriately

Especially if you're new to using animated GIF files in a web page, it's a really good 
idea to start with Animation Wizard.




